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Use the ProKitchen Online website (http://www.prokitchensoftware.com/prokitchen-online/) to get access to the program.

If you do not have access to the internet, you can still design with the ProKitchen Standalone Complimentary version (which does not 
require internet). However, in order to download the offline version, you do need access to the internet. Use the same login credentials 
and it can be downloaded from here: https://www.prokitchensoftware.com/program-downloads/

http://www.prokitchensoftware.com/prokitchen-online/
https://www.prokitchensoftware.com/program-downloads/
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Click on the ‘Sign In’ button, on the top right of the page. When dialog prompt appears type in your credentials then click the ‘Log In’ 
button.
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Click on the ‘Begin Your Design’ button to start up ProKitchen Online.

Note: ProKitchen will automatically create a shortcut on your desktop. We recommend that you leave this shortcut on your desktop for 
quick access to the program.
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1.1.1 To create a new design click the ‘Create a new design’ button.

1.1.2 Enter a design name in the ‘Design Name’ text field.

1.1.3 Click the ‘OK’ button. 

Training Exercise: Click the ‘Create a new design’ button, then click the ‘OK’ button.

1.1.3

1.1.2

1.1.1
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1.2.1 Click on the ‘File Tab’ menu and select ‘New’.

1.2.2 Enter a design name in the ‘Design File’ field and click the ‘Open’ button. This opens a window that allows you to select the file 
where your design will be saved.

1.2.1

1.2.2
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1.3.1 Use the dialog to select the location where the design will be saved.

1.3.2 In the text box type the file name for this design. Click the ‘Save’ button.

Training Exercise: Click the ‘Open’ button, select the file folder, type in the design name, and click the ‘Save’ button.

1.3.1

1.3.2
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1.4.1 Select a double arrow in the ‘Catalogs’ panel. ‘Show All’ or ‘Show Initialized’ options appear. By selecting ‘Show Initialized’ you can 
see only already initialized catalogs. By selecting ‘Show All’ you can see all the catalogs for which you have authorization from a cabinet 
vendor.

1.4.2 To initialize a catalog select a grey catalog name and press the ‘Initialize’ button. Since all the catalogs are stored in the Cloud in 
ProKitchen Online it becomes available in a few seconds and in ProKitchen Standard a catalog becomes available in a few minutes.

1.4.3 To uninitialize a catalog select a black catalog name and press the ‘Uninitialize’ button.

1.4.1

1.4.2

1.4.3
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2.1.1 To use predetermined wall layouts, click one of the ‘Wall Shapes’ buttons located on the ribbon panel.

Note: You may select ‘U-Shape Room’, ‘L-Shape Room’, or ‘Rectangle Room’.

2.1.2. To select the orientation of the walls click the corresponding button.

2.1.3 Type wall dimensions in the text boxes or use the up and down arrows and click the ‘OK’ button.

Note: Arrows on the left are Inches; arrows on the right are Fractions.

Training Exercise: Draw Wall ‘A’ to 156 3/8” and Wall ‘B’ to 136 5/8”.  Select ‘Wall Height’ 98” (Please use the same orientation as shown 
in the example). Remove these walls by clicking the ‘Undo’ button.

2.1.4 To draw walls click the ‘Sketch Walls’ button, then select the area to start the wall in.

2.1.1

2.1.5

2.1.3

2.1.2

2.1.4
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2.1.5 There are two different ways to set wall lengths. 

One: Use the text boxes in the right bottom bar, type in the dimensions and/or angle, and then press ‘Enter’.

Two: Click the left mouse button to draw the wall. To finish the wall and start an adjoining one click the left mouse button again. Left-
click behind the last wall drawn or press the escape key to finish drawing walls.

Note: When using the ‘Info’ window to enter dimensions keep your mouse still; moving the mouse will draw walls manually.

Training Exercise: Draw an L-Shape wall, with the starting point in the bottom left quadrant. Left Wall - 147” and Top Wall - 147 1/2” 
using the ‘Sketch’ Walls button.

Note: Click on the ‘Zoom To Fit’ button to resize the window (if necessary).

2.1.5
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3.1.1 To place a window click the ‘Windows’ button on the ribbon panel.

3.1.2 Open the ‘Windows’ folder to see the selection of windows by clicking the ‘Expand’ button or double-clicking the folder.

3.1.3 Click the window style to open the windows descriptions.

3.1.4 You can change the measurements of the window prior to placing it in the design.

3.1.5 To place a window highlight it, then click the ‘Place’ button.

3.1.1

3.1.2

3.1.3

3.1.5

3.1.4
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3.2.1 To place the window on the designated wall, guide the cursor to the wall zone and click the left mouse button. Slide the window 
along the wall to the selection position. Left click to set the window.

3.2.2 The position of the window is indicated in the info bar at the bottom and you can change it by using text boxes.

Note: After placing the window the dialog ‘Windows’ reopens again. If there are no more windows to place, close the window.

Training Exercise: Place a 72.5” x 60” window of your choice, 13” from the right, on the top wall using the ‘Info’ window.

3.2.2

3.2.1
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3.3.1 Select a cabinet line from the ‘Catalog’ window drop-down menu.

3.3.2 Select a cabinet category by clicking on the ‘Expand’ button (example Wall Cabinets – Glass Doors).

3.3.3 Select a cabinet type by clicking on the ‘Expand’ button (example 36” High). This shows all the cabinets available in the selected 
type.

3.3.4 Select a cabinet by clicking the cabinet type (example W3636-GL Standard Wall Cabinet Glass Door).

Double-click the nomenclature/description to bring up the product window. Select the cabinet and drag & drop into the ‘Placement 
Zone’.

3.3.1

3.3.2

3.3.3

3.3.4
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Note: Double-click on the picture in the info window to change it from 3D to black and white. While in the 3D view use the right mouse 
button to rotate and the center mouse button to zoom in and out on the item.

3.3.5 To place a cabinet using the ‘Find’ button, type a cabinet nomenclature or brief description and click the ‘Find’ button. This brings 
up all items containing the information that was entered. Select and place as before.

3.3.6 The ‘Info’ window shows a picture of the selected item.

Training Exercise: Using your manufacturer`s catalog place a 36”x36” Standard Wall Cabinet Glass Door. Place a W3636-GL by using 
the Find button.

Note: Close the ‘Cabinet’ window that appears after the cabinet is placed.

3.3.5

3.3.6
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3.4.1 Click the ‘Cabinet’ button in the ribbon panel.

3.4.2 Select the catalog line to be used.

3.4.3 Select the cabinet category by clicking on the ‘Expand’ button or double-clicking the folder.

Note: Cabinets may also be found using the ‘Find’ button.

3.4.4 Select the cabinet by clicking on the cabinet type. This will display all the cabinets available in the selected type.

3.4.5 Double-click on the nomenclature/description to bring up the product description window.

3.4.6 Highlight the cabinet to set it into the plan and click the ‘Place’ button.

Note: When an item is in the cursor, the cursor changes to a + sign.

3.4.1

3.4.2
3.4.3

3.4.5

3.4.6

3.4.4
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3.4.7 Place a cabinet by placing the cursor in the ‘Placement Zone’ and clicking the left mouse button.

Training Exercise: Place a Base Standard Cabinet 36” into the wall by using the ‘Cabinet’ button.
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Training Exercise: 

Place UC129024L on the left of the Refrigerator Enclosure, then place MTO369024-2 next to the RES369024.

Use any of the three ways to place these cabinets: ‘Cabinet button’, ‘Catalog’ drop-down menu, or ‘Find’ tool.
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Appliances can be placed using two of the three placement functions.

3.6.1 Use the ‘Catalog’ window to select the ‘GE Appliances’ catalog and select the appliance from the drop-down menu.

3.6.2 Use the ‘Appliances’ button from the ribbon panel to select the category, select the appliance from the drop-down menu and click 
the ‘Place’ button.

Training Exercise: Place a gas range and the refrigerator on the wall.

3.6.2

3.6.1
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3.7.1 To place a sink inside a cabinet, select the sink base. Right-click on the sink base, select the SKU and click Attributes. A dialogue 
box will appear and select ‘Sinks & Faucets’. Under Categories, double click the ‘Kitchen Fixtures’ folder, then select the ‘Sinks’ folder. Go to 
your desired sink category and double-click the folder to expand the options. Select the sink option that best fits what you are looking for 
by highlighting the name with your cursor. Click the ‘>’ button to move the sink into the SKU/Description/Measurement field. You will see 
the sink automatically install into the cabinet. Press ‘OK’ to finish.

3.7.2 For some sinks and faucets, you have the ability to change their color, by selecting a color you want from the available options.

3.7.1

3.7.2
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3.7.3 Sinks and faucets can be placed manually by using the ‘Plumbing’ button.

3.7.4 Sinks and faucets can also be placed by using the catalog window.

Select the ‘Plumbing’ catalog and scroll down to the sink then drag and place the sink as before.

Training Exercise: Place a farmhouse sink and faucet in the sink base cabinet.

3.7.3

3.7.4
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3.8.1 To place countertops, select the ‘Ctops & Molding’ tab, locate the countertop section and select the ‘Add All’ button. This will au-
tomatically place the countertop on all base cabinets.

Training Exercise: Place a countertop.

3.8.1
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4.1.1 Right-click on the item to be modified and select that item from the drop-down menu.

4.1.2 Slide the cursor down to Attributes and click the left mouse button. This brings up the Attributes window for the selected item.

Note: Double-clicking on the item will also bring up the Attributes window, but only if another item is not under the selected one (with 
select manufacturers).

4.1.1

4.1.2
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4.1.3 Dimension changes can be made to the selected items by entering new dimensions in the text boxes, using the up and down ar-
rows, or clicking on the modifications tab and selecting the correct dimension modification depending on the manufacturer. Click the ‘OK’ 
button once the changes are made to save the changes.

Note: If there is a modification available in the modification tab do not use the text boxes or arrows to make dimension changes. The 
dimensions will change, but the pricing will be incorrect.

4.1.3
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Training Exercise: 

Change the W1230 to 9” deep (if your manufacturer allows this modification). 

Change the width of the window to 60” by using the ‘Attributes’ window.
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4.2.1 By using advanced modifications you can open vertical doors on different types of cabinets.

Note: This will also work in 3D as explained in ‘32.6 - Open/Close Doors’ segment.

4.2.1
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There are three different ways to view an Inside Wall Elevation:

5.1.1 Right-click on the wall and select Wall, Wall #, and ‘Inside Elevation’ from the drop-down menus.

5.1.1
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5.1.2 Select the wall and click the ‘Elevation’ button on the ribbon panel.

5.1.3 Use ‘Ctrl + Click’ on the zone to bring up Elevation for this wall.

5.1.4 To view each wall elevation click on the corresponding tab.

Note: Each elevation can have multiple views of the same elevation. So, it is best to relabel the elevation title to avoid having multiple of 
the same view.

5.1.2

5.1.4

5.1.3
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6.1.1 To view 3D in color click the ‘3D’ button.

6.1.2 To view 3D in black and white click the ‘No Color’ radio button.

6.1.2

6.1.1
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Press and hold the left mouse button to move the 3D view up/down or left/right. 

Press and hold the center mouse button to zoom by moving the mouse front and back. 

Press and hold the right mouse button to rotate the view. 

Buttons are also provided on the bottom toolbar for controlling the same functions.

Training Exercise: Click the ‘3D’ button and use the three mouse buttons then close the 3D window.
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6.2.1 You can send a link to your 3D view via email, by using the corresponding button on the bottom toolbar.

6.2.1
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6.2.2 You can send a link to your 3D view directly to the smartphone of your recipient, by using the corresponding button on the bottom 
toolbar.

6.2.2
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6.3.1 For creating a panorama view open 3D. On the top toolbar click on the ‘Create Panorama’ button and this will bring up a sidebar. 
Available actions:

- Select the render quality in the drop down.

- Position the Camera. It will always default to the center of the room.

6.3.2 After adjusting the camera position and render quality setting, click on the ‘Render’ button to start rendering the panorama.

6.3.2 6.3.1
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After the rendering process is complete panorama will appear on the screen.
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6.3.3 By using the corresponding button, shown in the image above, you can send the newly created panorama in an email to your re-
cipient.

6.3.3
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6.3.4 You can also text the newly created panorama to your recipient by using the smartphone icon, shown in the image above.

6.3.4
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6.3.5 You can access a table with a list of all existed panoramas and informative dialog using the ‘Gallery’ button from the ‘Presentation’ 
tab of the ribbon panel.
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7.1.1 To set cabinet pricing and details click on the ‘Global Options’ button located under the ‘View & Settings’ tab.

7.1.2 Select the cabinet catalog using the ‘Catalogs’ drop-down menu.

7.1.3 <Please click to select> indicates that there is no set option for a specific category. Selecting it will bring up all the options available 
for the selected item. Each manufacturer will have different sets of options.

7.1.4 Set each category value by double-clicking on the option. Once all Global Options are set the window can be closed.

Training Exercise: Set the Global Options.

Note: Global Options set the cabinet values, door styles, and finishes assigned to the project. The door styles and finishes selected in 
this section will be shown in 3D.

7.1.1

7.1.2

7.1.3

7.1.4
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Note: For Manufacturer Catalogs only

7.2.1 The PDF icon brings up the manufacturer`s spec book page that refers to the selected item.

7.2.2 Use the drop-down menu to increase and decrease the size of the page(s).

7.2.3 Type the number you want to find in the page box.

7.2.4 Click on the icon in the upper right corner to close this window.

Training Exercise: Click the PDF icon and navigate the Spec Book page(s), then close the window. Close the Global Specification window.

7.2.4

7.2.3 7.2.2
7.2.1
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8.1.1 Click the ‘Manufacturer Report’ button to set up the information for the Manufacturer Report.

8.1.1
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8.1.2 The toolbar allows navigation of the Manufacturer Report such as saving, printing, paging up/down, and zooming. The report 
shows all the cabinet information including door styles, finishes, cabinets, accessories, cost, shipping, and customer information.

Training Exercise: Create a Manufacturer Report, navigate through it then close the window.

8.1.2
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9.1.1 To place the order via the internet or send the design to another user please switch to the ‘File’ tab, then select ‘Share’ > ‘Send 
Using Email’.

Note: When using this button the recipient(s) must have the same or newer version of the ProKitchen program.

9.1.2 This window works the same as most email accounts. Enter email addresses, notes, and attachments as necessary.

Note: Do not email the order unless you would like it to be emailed to the recipient.

9.1.1

9.1.2
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9.2.1 Select the ‘Electronic Orders’ tab on the ribbon panel and click the ‘EZ-Link’ button to place the order via the internet.

9.2.2 Depending on the Manufacturer’s Electronic Ordering System, you will either have to save the electronic report into a designated 
file, click ‘Save’, and then upload that exported file into the Manufacturers Ordering website or the Manufacturer’s website will automati-
cally appear for you to place the order instantly.

9.2.2

9.2.1
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There are six different View Panels. View Panels include Design, Info, Catalogs, Global Options, Bill of Materials, and Elevation. Each View 
Panel can be shown on the screen at the same time or individually. Elevation, Design, Bill of Materials, or Global Options view panels can 
be dragged and dropped or even moved to another screen.

10.1.1 To hide a view window click the ‘X’ in the upper right corner of the View Panel. 10.1.2 To show a view window either click the 
corresponding button on the top toolbar or use the View drop-down menu. 10.1.3 To adjust a View Panel place the cursor on the window’s 
edge, when a double-headed arrow appears click and hold the left mouse button and slide the cursor (View Panel window) to the desired 
position.

Training Exercise: Open all panels, expand a panel to full screen and return it back to standard size then close the Bill Of Materials (BOM), 
Global Options, and Elevation panels.

10.1.2

10.1.1

10.1.3



47PAGE -10.2 RIBBON PANEL

Edit tab: 

Use this tab to edit a design, undo/redo your actions, or to change product attributes, modifications, and accessories.

Draw & Place tab: 

Use this tab to create/edit walls on the design, mirror items horizontally/vertically, place different design items, search for models or 
verify your design according to NKBA standards.

Doors & Windows tab: 

Use this tab to select, place and edit windows/doors in the design.

3D & VR tab: 

Use this tab to access 3D windows, control view options, access wall/floor/countertop/ceiling options, and panorama settings.
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Reports tab: 

Use this tab to create and set up different types of reports.

Presentation tab: 

Use this tab to access Dynamic Design Showcase and Panoramas.

Electronic Orders tab: 

Use this tab to export data to the EZ-Link system, XML, Spruce, Saberi’s, and QuickBooks.

Measurement & Comments tab: 

This tab allows the placement of dimensions on the design plan, comments, and additional lines.
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View & Settings tab: 

Use this tab to access zooming options, set up view options, access Plan/Elevation/BOM windows and different settings as well 
as gain access to Image Collection.

Ctops & Moldings tab: 

Use this tab to access Countertop/Closet Designer windows and to control countertops, backsplashes, moldings, and lightings.

Catalog & Solutions tab: 

Use this tab to add new solutions, update, copy, uninstall, or switch catalogs.

Search tab: 

This tab allows you to search for existing designs and customers.



50PAGE -10.3 PROKITCHEN CHAT

10.3.1 You can contact our support team directly from the program. Click on the ‘Chat with Us’ button on the ribbon panel.

10.3.2 Enter your contact phone number and write down your issue or question and click the ‘Send Message’ button. Our support team 
will contact you shortly.

10.3.1

10.3.2



51PAGE -10.4 FAVORITES TOOLBAR

10.4.1 To Enable/Disable the ‘Favorites Toolbar’ please click on the button at the top right corner.

10.4.2 To Show/Hide the ribbon panel use button in the top right corner.

10.4.2

10.4.1



52PAGE -10.5 FILE TAB

10.5.1 To access the file tab please click on the blue ‘File’ button in the top left corner of the ribbon panel.

10.5.1
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10.5.2 The file tab allows you to create, open, save, print, and share your designs, export/import data, edit application settings, and ac-
cess account information in the help section.



54PAGE -11.1 DESIGN SETTINGS - DESIGN TAB

11.1.1 Click on the ‘Design Settings’ button in the ‘View & Settings’ tab of the ribbon panel to open up the Design Settings dialog. Design 
Settings – the settings that apply only to the current design.

11.1.2 Select the Design tab to access the design information panel. This panel contains the Contact #, Order #, Design Status, Pro-
cessed By, Date Created, Last Modified, and Notes.

11.1.3 Use the drop-down menu to set the status of the current project.

11.1.4 The design creation date is automatically created when a design is started. The Last Modified Date will automatically update 
when the project is changed.

11.1.5 The ‘Note’ text box is used to apply notes to the current project and will appear on the front page of the ‘Customers Report’.

Training Exercise: Fill in all fields and dropdown menus, then click the ‘Units’ tab.

11.1.3

11.1.2

11.1.4

11.1.5

11.1.1



55PAGE -11.2 DESIGN SETTINGS - UNITS TAB

11.2.1 Select the ‘Units’ tab to access the units information panel.

11.2.2 To select the dimension style click on the corresponding radio button.

Example: Metric is 914 mm; Imperial Inches is 36”; Imperial Feet-Inches is 3’ - 0”.

Training Exercise: Select the Imperial Inches radio button and select the ‘Customer’ tab.

11.2.1

11.2.2



56PAGE -11.3 DESIGN SETTINGS - CUSTOMER TAB

11.3.1 Select the ‘Customer’ tab to access the customer information panel. 

11.3.2 Before any information can be entered a customer database needs to be created. To create a customer database click the 
‘Browse’ button. 

11.3.3 To create a new customer click on the ‘New’ button. This will brings up the ‘New Customer’ window.

11.3.3

11.3.2

11.3.8

11.3.1
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11.3.4 Customer information is entered into the provided text boxes. The names and/or information entered into the ‘First Name’ and 
‘Last Name’ text boxes will show in the ‘Customer’ and ‘Manufacturer’ reports. 

11.3.5 Click the ‘Address’ button to enter the address information. 

11.3.4

11.3.5
11.3.7
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11.3.6 Enter the customer`s address information in the text boxes and drop-down menus as necessary. 

11.3.7 Use the ‘Same As Mailing’/’Same As Shipping’ check boxes if the address is the same. 

11.3.8 To select an existing customer, highlight the customer line and click the ‘Select’ button or double-click the line.

Note: See the previous page for details.

Training Exercise: Create a new customer and click the ‘OK’ button. Select the newly created customer and click the ‘Dealer’ tab.

11.3.6
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11.4.1 Select the ‘Dealer’ tab to access the dealer information panel.

11.4.2 All the dealer information is entered into the provided text boxes under the ‘Dealer’ tab.

11.4.3 The address information is entered in the same format as in the ‘Customer’ tab.

11.4.4 Use the ‘Clear’ button to clear all current information.

Note: Once the ‘OK’ button is clicked the information on this tab will hold in the program. There is no need to enter this information on 
every design.

Training Exercise: Fill in all the dealer information including the address then click the ‘Designer’ tab.

11.4.2

11.4.3

11.4.4

11.4.1
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11.5.1 Select the ‘Designer’ tab to access the designer information panel.

11.5.2 To create a new designer or select an existing one click the ‘Browse’ button. This works in the same manner as the ‘Customer’ 
tab.

11.5.3 The ‘Same as Dealer’ and ‘Same as Supervisor’ buttons are used if the information is the same.

Training Exercise: Set up a new designer using the ‘Browse’ button then click the ‘Supervisor’ tab.

11.5.1

11.5.3 11.5.2



61PAGE -11.6 DESIGN SETTINGS - SUPERVISOR TAB

11.6.1 The ‘Supervisor’ tab is completed the same as the ‘Designer’ tab.

Training Exercise: Create a new ‘Supervisor’ then click the ‘Construction’ tab.

11.6.1



62PAGE -11.7 DESIGN SETTINGS - WALLS TAB

11.7.1 Select the ‘Walls’ tab under the ‘Construction’ category to access different settings for walls.

11.7.2 To set the thickness of the walls use the up/down arrows or type in the wall thickness. 11.7.3 To set the zone width use the up/
down arrows or type in the zone width. The zone width is the space in which items are placed. 11.7.4 To set the wall height use the up/
down arrows or type in the wall height for the current project. This sets all the walls at the height entered. See the walls section to change 
the height of each wall. 11.7.5 Select ’Apply to existing walls’ if desired, to be applied to all existing walls. 11.7.6 To set the Wall Cabinet 
position from the Ceiling or Floor choose the ‘Top Alignment’ or ‘Bottom Alignment’ and then determined the distance measurement. Ex-
ample: To set a wall cabinet 54” from the Floor, you would choose Bottom Alignment and 54”.

Training Exercise: Set the construction settings:

1. Wall Thickness = 4 1/2”; 2. Zone Width = 30”; 3. Wall High = 108”; 4. Bottom Alignment = 54”; 5. Click the Countertop tab;

11.7.1

11.7.2

11.7.5

11.7.3

11.7.4

11.7.6
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11.8.1 Select the ‘Countertop’ tab to access the countertop information panel.

11.8.2 Use the up/down arrows or type dimensions in the text boxes to set the countertop overhangs and the thickness of the counter-
top.

11.8.3 In the same window we select the backsplash depth and height.

Training Exercise: Set the countertop overhangs and thickness (if needed), then click the ‘Other’ tab.

11.8.2

11.8.3

11.8.1



64PAGE -11.9 DESIGN SETTINGS - OTHER TAB

11.9.1 Select the ‘Other’ tab to access other construction settings.

11.9.2 ‘Additional Weight (pallet)’ – Select the value by either using the up/down arrows or typing in the value. 

11.9.3 ‘Dimension Nomenclature Orientation’ – We can use either default or 45 clockwise/45 counter clock-wise or 90 clockwise/ 90 
counter clock-wise. 

11.9.4 We can select the offset from the hood in the field ’Auto-offset Hoods from Cabinets’ by using the arrows or typing into the field.

Training Exercise: Set other construction parameters (if needed), then click the ‘Moldings’ tab.

11.9.1

11.9.2

11.9.3

11.9.4



65PAGE -11.10 DESIGN SETTINGS - MOLDINGS TAB

11.10.1 Select the ‘Moldings’ tab to access the molding information.

11.10.2 To set the default for ‘Light Rail Moldings’ and ‘Top Moldings’ select the appropriate check boxes then choose the cabinet cat-
alog(s) and molding type(s) using the drop-down menus.

11.10.3 Similar to selecting molding, click to select a toe-kick. Once selected use the drop-down list to view and select one of the avail-
able toe-kicks.

11.10.1
11.10.2

11.10.3
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11.11.1 If you want to add lighting to the molding or toe-kick, use the ‘Molding Lighting’ tab. Put a checkmark against those moldings 
to which you would like to add lighting. After that, select the wattage for each lighting source by using the horizontal scroll bar. Finally, you 
can specify the distance between the lighting. That distance determines the number of lighting sources per molding.

Note: If stacking moldings (a sub crown with a crown) select the 1st piece of molding that is to be placed onto the top of the upper (and 
tall) cabinets in this window. The additional stacked molding will be dragged and dropped onto the 1st piece of molding selected in this 
window. This is covered in the placing molding section.

Training Exercise: Check the ‘Light Rail Molding’ check box, select the newly created catalog and choose a light rail molding. Check the 
‘Top Molding’ check box, select the newly created catalog and choose a sub-crown molding, then Check the Toe-Kick Lighting and choose 
a toe-kick. Then click the ‘Textures’ tab.

11.11.1



67PAGE -11.12 DESIGN SETTINGS - TEXTURES TAB

11.12.1 Select the ‘3D’ tab to access the 3D information panel. 

11.12.2 To set the Materials, Styles, and Colors for the Countertops, Walls, and Floor, click the ‘Select’ button.

11.12.3 Use the provided text box to type in a brief description of the material, style, color, or pattern of the item.

Example: Type in ‘Floral’ and it will show all the floral patterns found in the program. 

Note: Any material can be used on any select surface.

11.12.1 11.12.2

11.12.3
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11.12.4 Use the category list to select the different types of materials to be used on the selected item. The selected materials show in 
the list below and can be scanned through to find the desired color, pattern, and/or style. Click on the small picture of an item and a larger 
sample appears on the right. Double-click on the large sample to select.

11.12.5 Use the ‘Add To Favorites’ button to add the current selection to the favorites section above. If the desired selection is in the 
favorites section double-click on that item to make the selection for the selected item. Use the ‘Delete’ button to delete the selected item 
from the favorites menu. Use the ‘Delete All’ to delete all the items from the favorites list.

11.12.6 Once the selection is made click the ‘OK’ button to secure the selection. These selections will be shown in the 3D view(s).

Training Exercise: Set the colors, styles, and/or patterns for the countertops, walls, floor, and ceiling. This finishes the Design Settings.

11.12.5

11.12.4

11.12.6



69PAGE -12.1 DEFAULT SETTINGS - APPLICATION TAB

To set ‘Default Settings’ select ‘Settings’ from the menu bar and choose ‘Default Settings’. Default Settings – general settings that apply 
to the whole program, they do not change after the program restart.

The ‘Application’ tab is used to set the file path by using the browse button and selecting the default folder where all designs will be 
saved to. This window also allows the user to enable and disable the Auto-save/Auto-backup options as well as set their time intervals. 
The Direct3D and OpenGL options are used for various graphics cards. If you have problems with the 3D option please change this setting 
to the other and try the 3D option again. If this doesn’t remedy the problem call Customer Support. 

You can also change the application language and set up your company’s logo here.



70PAGE -12.2 DEFAULT SETTINGS - APPEARANCE TAB

The ‘Appearance‘ tab is used to set different visual settings of the application.

‘Appearance’ and ‘Dialog style’ options allow you to switch from standard to classic appearance, where ‘Standard’ is the modern UI with 
a ribbon panel and ‘Classic’ is without it.

The ‘Info Panel’ will set the image type to appear in the info panel in various windows. The ‘Image’ shows a black and white line drawing, 
while the ‘3D’ shows a fully rotational view of the actual selected item.

Note: Setting the default to ‘Image’ will increase the overall performance and speed of the program.

Using the ‘Font Size’ setting you can choose usable Font Size and Icon Size, choose - 100%, 125%, 150%, or 200%. A restart of ProKitchen 
is required to apply the changes.



71PAGE -12.3 DEFAULT SETTINGS - UNITS TAB

12.3.1 Select the ‘Units’ tab to access the units information panel.

12.3.2 To select the dimension style click on the corresponding radio button.

12.3.2
12.3.1



72PAGE -12.4 DEFAULT SETTINGS - WALLS TAB

12.4.1 Select the ‘Walls’ tab under the ‘Construction’ category to access default settings for walls.

12.4.2 To set the thickness of the walls use the up/down arrows or type in the ‘Wall Thickness’.

12.4.3 To set the zone width use the up/down arrows or type in the ‘Zone Width’. The zone width is the space in which items are placed.  

12.4.4 To set the wall height use the up/down arrows or type in the wall height for the current project. This sets all the walls at the height 
entered. See the walls section to change the height of each wall. 

12.4.5 Wall cabinet heights can be determined by using the dropdown menu. Set the ‘Top Alignment’ or the ‘Bottom Alignment’.

12.4.1

12.4.2

12.4.3

12.4.4

12.4.5
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12.5.1 The ‘Cabinets’ tab is used to set a custom cabinet heights and depths for the ProKitchen catalog only and will not affect the 
manufacturer’s catalogs.

12.5.2 The depth and height of the Base, Wall, Vanity, and Desk Base Cabinets can be specified with the help of arrows up/down.

12.5.1 12.5.2



74PAGE -12.6 DEFAULT SETTINGS - COUNTERTOP TAB

12.6.1 Select the ‘Countertop’ tab to access the countertop information panel.

12.6.2 Use the up/down arrows or type dimensions in the text boxes to set the countertop overhangs and the thickness.

12.6.3 In the same window choose the depth and height of the backsplash.

12.6.1 12.6.2

12.6.3
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12.7.1 Select the ‘Other’ tab to access other construction settings.

12.7.2 To change ‘Additional Weight (Pallet)’ use the up and down arrows or type in the text box. 

12.7.3 ‘Dimension Nomenclature Orientation’ has the following options:  Default, 45° Clockwise/45° Counter Clockwise, or 90° Clock-
wise/90° Counter Clockwise.  

12.7.4 Set a desirable offset from the cabinet to the hood by using ‘Auto-offset Hoods from Cabinets’.

12.7.1

12.7.3
12.7.4

12.7.2
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12.8.1 Select the ‘Moldings’ tab to access the molding information.

12.8.2 To set the default for ‘Light Rail Molding’ and ‘Top Molding’ select the appropriate check boxes then choose the cabinet cata-
log(s) and molding type(s) by using the drop-down menus.

12.8.3 You can set up the ‘Toe Kick’ in the same way as moldings.

12.8.1 12.8.2

12.8.3
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12.9.1 If you want to add lighting to the molding or toe kick, use the ‘Molding Lighting’ tab.

12.9.2 To enable the lighting select the checkboxes next to Light, Top, or Toe Kick. Next, select the lighting power by moving the slider, 
and use the up-down to select the distance between the light sources.

12.9.1 12.9.2



78PAGE -12.10 DEFAULT SETTINGS - TEXTURES TAB

12.10.1 Select the ‘Textures’ tab to access the textures information panel. 12.10.2 To set the Materials, Styles, and Colors for the 
Countertops, Walls, and Floor, click the ‘Select’ button next to the sample box. 12.10.3 Use the category list to select the different types of 
materials to be used on the selected item. Find the desired color, pattern, or style in the list and click on the small picture of an item and 
a larger sample appears on the right. Double-click on the large image to select. Note: Any material can be used on any selected surface. 
12.10.4 Use the provided text box to type in a brief description of the material, style, color, or pattern of the item that is needed. Example: 
Type in ‘Floral’ and it will show all the floral patterns found in the program. 12.10.5 Use the ‘Add To Favorites’ button to add the currently 
selected item to the ‘Favorites’ section. You can select an item from this section, by double-clicking on it. Use the ‘Delete’ button to delete 
the selected item from the favorites menu or use the ‘Delete all’ to delete all the items from the favorites list. 12.10.6 Once the selection is 
made click the ‘OK’ button to apply it. These selections will be shown in the 3D view(s). 12.10.7 You can rotate the selected textures using 
the ‘Rotate’ button if you need.

12.10.1
12.10.2

12.10.7

12.10.4

12.10.5

12.10.6

12.10.3



79PAGE -12.11 DEFAULT SETTINGS - CUSTOMER REPORT TAB

12.11.1 In the ‘Customer Report’ tab you can select catalog and enter the required upcharge or discount, then select the percentage or 
premium.

12.11.1



80PAGE -12.12 DEFAULT SETTINGS - EMAIL SETTINGS TAB

12.12.1 In the ‘Email Settings’ tab, you can set up the server settings on how the program should work with the emails, and whether it 
should attach the design files to them or not.

12.12.1
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12.13.1 To make your design with the cabinets in different finishes or colors you would need to make a copy of the catalog. Select the 
‘Copy Catalog’ button from the ‘Catalog & Solutions’ category in the ribbon panel.

12.13.2 Select the catalog you want to make a copy of and click the ‘Copy’ button.

12.13.3 Type in the catalog copy name in the dialog window and click ‘OK’.  The new catalog appears in the catalog list on the left panel.

12.13.4 Customize your color choices for cabinets, moldings, fillers, and accessories. To customize your color choices right-click on the 
item and select ‘Change Color’ > ‘Create Catalog Copy’. The same can be done with multiple selections or groupings (by lasso). The copy 
catalogs are created automatically. If changed to a different catalog, global options will open automatically.

12.13.1

12.13.4

12.13.2

12.13.3



82PAGE -12.14 IMAGE COLLECTION

12.14.1 ‘View & Settings’ > ‘Image Collection’ - by using this window you can add custom images. They can be used as backgrounds for 
windows, glass doors, flooring, drawing on the wall, etc.

12.14.2 To add the image from your computer, create a folder by using the ‘Add Folder’ icon. The folder with the name ‘New Folder’ will 
appear. Rename it by double-clicking. Delete by clicking ‘Remove’. To rename a folder or image click the ‘Edit’ button.

12.14.3 Click on the created folder and click ‘Add Image’. In the dialog find the image file you want to add and click the ‘Select’ button.

12.14.4 You can edit the added image by clicking the ‘Edit’ button. In the new window, you can specify or correct the size. The image can 
also be moved or mirrored. When all parameters are set, press the ‘OK’ button. The added image will appear in the 3D - ‘User Collection’.

12.14.4

12.14.1

12.14.3

12.14.2
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12.14.5 If you need to add a specific color, you can use the Eyedropper Tool by clicking on the ‘Add Color’ icon.

12.14.6 After you select a color you want, it will be displayed in the preview window and all you have to do is type in a name and click 
the ‘OK’ button.

12.14.6

12.14.5



84PAGE -13.1 DISPLAY SETTINGS - LAYERS TAB

Display Settings – the settings that apply to the whole program controlling screen appearance and the elements on the plan view and 
elevation: labels, lines style, and color, grid style, cabinet visibility, wall zones, etc.

13.1.1 To access the ‘Display Setting’ dialog use the corresponding button from the ribbon panel.

13.1.2 Select the ‘Layers’ tab to access the layers info panel.

13.1.3 You can select which components to display on the plan and which to hide.

13.1.4 Clicking on the right buttons you can select the font, color, and line, which will separate a particular element.

Training Exercise: Change the ‘View 1’ tab to say ‘Complete Design’, change the ‘View 2’ tab to say ‘Wall Cabinets’, change the settings 
in the ‘View 2’ tab to show only wall cabinets, and change the wall cabinet’s color to red and make the outside line thicker and change the 
‘Display Label’ to show cabinets with the nomenclatures and dimensions.

13.1.4

13.1.1

13.1.3
13.1.2
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13.2.1 By using the ‘Themes’ tab you can select one of the color schemes for the elements displayed on the Plan and Elevation panels. 
These settings can be overwritten by using the ‘Layers’ tab selections.

13.2.1
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13.3.1 The ‘Dimensions’ tab is used to set specific measurements within the window.

13.3.2 To toggle dimensions on or off check the box next to each description.

13.3.3 ‘Appliances’ and ‘Room Elements’ (windows and doors) can be dimensioned from the center or from each side.

13.3.2

13.3.3

13.3.1



87PAGE -13.4 DISPLAY SETTINGS - STYLE TAB

13.4.1 In the ‘Style’ tab you can adjust the visual style of different measurement elements.

13.4.1



88PAGE -13.5 DISPLAY SETTINGS - SELECTION TAB

13.5.1 The ‘Selection’ tab is used to set the selection line color and thickness, allowing you to set handles settings and select their style.

13.5.1



89PAGE -13.6 DISPLAY SETTINGS - GRID TAB

13.6.1 The ‘Grid’ tab is used to set the grid line color, background color, and size.

13.6.2 Spacing is used to set the grid spacing. Use either the up and down arrows or type the dimension in the text boxes.

13.6.3 The line color and background color work in the same way as shown before.

13.6.4 The ‘Default’ button resets the settings back to the original values.

Training Exercise: Change the background and line colors on the new ‘Wall Cabinet’ tab.

13.6.2

13.6.3

13.6.4

13.6.1
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13.7.1 The ‘Save/Load’ tab is used to save current display settings and to load previously saved settings.

13.7.2 The ‘Save Settings’ button is used to save the current display settings. The ‘Save Settings’ window is where the newly created 
display settings are saved. Create this display settings name in the text box and click the ‘Save’ button.

13.7.3 The ‘Load Settings’ button is used to load previously created display settings. To load the display settings highlight the setting 
name and click the ‘Open’ button or double-click on the name. This will load the settings into the current design window(s).

13.7.4 The default button sets the current plan back to the program defaults.

Training Exercise: Save the current settings as a file.

13.7.1

13.7.3
13.7.2

13.7.4



91PAGE -14.1 GLOBAL OPTIONS INTERFACE

14.1.1 To set the cabinet door styles, wood species, finishes, construction, and many other options click on the ‘Global Options’ button.

14.1.2 Select the cabinet catalog using the Catalog drop-down menu.

14.1.3 To set each option highlight the <Click To Select> box. This brings up all the options available for the selected item. Each manu-
facturer will have different settings. Each <Click To Select> box must be selected.

14.1.4 Set each value by double-clicking on the selection. Information appears in the ‘Info’ window when the selection is highlighted.

Training Exercise: Set the Global Options (These will be used in the following designs).

Note: With the Global Options, you can set the cabinet settings like the door styles, and finishes assigned to the project. The door styles 
and finishes selected in this section will be shown in 3D.

14.1.1

14.1.2

14.1.4

14.1.3
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14.1.1 ‘Horizontal View’ and ‘Vertical View’ buttons in the top right corner of the ‘Global Options’ panel are used to adjust how the panel 
segments are displayed.

14.1.2 ‘Icons View’ and ‘List View’ buttons are used to switch between two data visualization modes.

14.1.5

14.1.4



93PAGE -14.2 CUSTOM PRICING FOR PROKITCHEN CATALOG

14.2.1 ‘Global Options’ allow you to adjust custom pricing to the ProKitchen catalog when you set each option.

14.2.1



94PAGE -14.3 GLAZING AND SHEEN

14.3.1 We implemented a brand new 3D technology to visualize ‘Glazing’ and ‘Sheen’ effects, that you can set up in ‘Global Options’.

14.3.1



95PAGE -15.1 ROTATING WALLS

Training Exercise: Sketch an L-Shape wall as shown above (Left Wall is 165 1/2’”and Top Wall is 150”).

15.1.1 To rotate a wall right-click on the wall, select the ‘Wall’ sub-menu and then select ‘Rotate’. 15.1.2 To select the pivot point, click 
on the end of the wall to be pivoted. 15.1.3 To pivot the wall move the cursor to the desired angle and left-click to set the wall.

Note: The angle is shown in the Info window.

15.1.4 After setting the pivot point, the angle can be set using the text box in the Info window. 15.1.5 To turn the wall without using the 
menu, you can pull on the green arrow, and select the desired direction.

Training Exercise: Rotate the Top Wall to a 56’ degree angle by either rotating the wall with the mouse or using the Info text box. Use the 
‘Undo’ button to reset the wall to the original angle.

15.1.5

15.1.1

15.1.2



96PAGE -15.2 MOVING WALLS

15.2.1 To move a wall right-click on the wall, select the ‘Wall’ sub-menu, select the wall then select ‘Move’.

15.2.2 Click on an adjacent wall to move the selected wall up or down changing the length of the adjacent wall.

Note: This will change the length of the adjacent wall(s). Click the selected wall to move the wall left or right.

Note: This will change the angle of all attached wall(s).

15.2.3 Moving the wall without using the menu, you can simply pull on the green arrow in the arrow direction you want.

Training Exercise: Move the Top Wall up and down then click to set. Then move the top wall left and right then click to set. Use the ‘Undo’ 
button to reset the wall to its original position.

15.2.1

15.2.2 15.2.3



97PAGE -15.3 RESIZING WALLS

15.3.1 To resize a wall right-click on the wall, select the ‘Wall’ sub-menu, select the wall and then select ‘Resize’.

15.3.2 Slide the cursor to the desired wall length and left-click to set the wall.

15.3.3 By clicking on the green arrow in the direction you want, you can just change the size of the wall, without using the menu.

Note: The wall dimension is shown above the wall and in the Info box.

Training Exercise: Resize the Top Wall to 76 13/16”. Use the ‘Undo’ button to reset the wall to the original size.

15.3.1

15.3.3



98PAGE -15.4 BENDING WALLS

15.4.1 To bend a wall right-click on the wall, select the ‘Wall’ submenu and then select ‘Bend’.

15.4.1



99PAGE -15.5 EXTRUDING WALLS

Extruding a wall can be used to create duct spaces, boxed windows, etc.

15.5.1 To extrude a wall right-click on the wall, select the ‘Wall’ submenu and then select ‘Extrude’.

15.5.1



100PAGE -15.5 EXTRUDING WALLS

15.5.2 A small box will appear on the wall. This box is the starting point for the extrusion. Slide this box to the starting point of the ex-
trusion and left-click to start the extrusion.

Note: Dimensions are located above the wall and in the Info text boxes.

15.5.3 Slide the cursor to the desired extrusion length, width, and/or depth.

Note: The extrusion can be placed on the inside or outside of the wall. Zoom into the extrusion location to set more precise dimensions 
or use the text box.

Training Exercise: Place an extrusion on the Top Wall. Use the ‘Undo’ button to reset the wall to the original size.

15.5.2



101PAGE -15.6 ADDING WALLS

15.6.1 To add a wall right-click on the wall, select the ‘Wall’ sub-menu, and then select ‘Add Wall’.

15.6.2 A small box will appear on the wall. This box is the starting point for a wall to be added. Left-click to start the wall.

Note: Dimensions are located above the wall and in the Info text boxes.

15.6.3 Slide the cursor to the desired length for the added wall, then left-click to set the wall.

15.6.4 To add a new wall to the outside of the existing one, left-click on the outside of the wall and follow the same steps.

Training Exercise: Add new walls to the inside and outside of the Top Wall. Delete the added walls by left-clicking the walls and pressing 
the ‘Delete’ key.

15.6.1

15.6.3

15.6.4
15.6.2



102PAGE -15.7 ADDING CONSTRUCTION WALLS

15.7.1 A construction wall is used for adding peninsulas and islands to a design. Construction walls are added in the same manner as 
adding walls.

15.7.1



103PAGE -15.8 CONTINUING WALLS

15.7.1 To continue a wall right-click on the wall, select the Wall submenu, and then select ‘Continue Wall’.

15.7.2 (a) A new wall will appear on the end of the selected wall. (b) The wall length can be determined by using the Info text box or by 
sliding the cursor to the desired length and left-clicking. (c) Enter the wall dimension and/or angle and hit the ‘Enter’ key. (d) Right-click to 
locate the continued wall. Right-click again to set the angle and change the length. (e) Left-click to set the wall length and continue with 
the next wall. To end the continued wall hit the ‘Escape’ key or click the cursor behind the wall.

Note: Dimensions are located along the wall and in the Info text box.

Training Exercise: Add a 48” wall at 135 degrees of the 150” wall then add a 72” wall at 135 degrees of the new 48” wall.

15.8.2

15.8.2

15.8.2

15.8.1



104PAGE -15.9 WALL ATTRIBUTES - GENERAL TAB

Wall Attributes change the wall settings.

15.9.1 To change the attributes of a wall, right-click on the wall, select the ‘Wall’ sub-menu then select ‘Attributes’.

15.9.2 The radio buttons change the selected wall to a solid wall or a construction line.

15.9.3 The checkboxes add and/or delete a placement zone to the selected wall.

15.9.4 The up/down arrows and text boxes are to set the wall thickness, length, and/or heights.

Training Exercise: Change the Right Wall’s (72” long wall) height to 40 1/2” and place an inside and outside placement zone.

15.9.1

15.9.2

15.9.3

15.9.4



105PAGE -15.10 WALL ATTRIBUTES - CURVATURE TAB

15.10.1 The ‘Curvature’ tab gives access to the curvature info panel.

Sector refers to the area of the room within the radius wall.

Depth refers to the distance from the edge of the adjoining walls to the furthest point on the curvature.

Radius refers to the length of the curved wall from the edge of the adjoining wall to the center point of the curvature. With the radius 
option, you may also choose to make the curvature larger than a semicircle by left-clicking the box to the left of this option below. Which 
will then create a more circular room as the dimensional parameter entered will allow.

15.10.1



106PAGE -15.11 WALL ATTRIBUTES - CATHEDRAL TAB

15.11.1 The ‘Cathedral’ tab gives access to the cathedral info panel.

Vault position refers to the distance from the left adjoining wall to where the peak of the ceiling will be in relation to the distance mea-
sured on the floor.

Vault height refers to the height of the top-most peak of the ceiling in relation to the top of the adjoining wall height the cathedral length 
section you may choose to create this ceiling shape to the next wall, which is the wall opposite of the selected wall, or you may turn that 
option off by left clicking the box to remove the checkmark. Then in the ‘Specified Length’ box, enter the distance in which this cathedral 
ceiling will continue into the room.

Note: Only one cathedral shape may be rendered within a single design and must be created on the wall that will hold the highest peak.

15.11.1



107PAGE -15.12 WALL ATTRIBUTES - MATERIAL TAB

15.12.1 The ‘Material’ tab allows you to adjust wall material.

15.12.1



108PAGE -15.13 WALL ATTRIBUTES - TEXTURES TAB

15.13.1 Select the ‘Textures’ tab to access the textures information panel. 

15.13.2 To set the Inside and/or outside Texture, click the ‘Select’ button adjacent to the sample box.

15.13.3 Use the category list to select the different types of materials to be used on the selected item. The selected materials show in 
the list and can be scanned through to find the desired color, pattern, and/or style. Click on the small picture of an item and a larger sample 
appears on the right. Double-click on the large sample to select.

15.13.4 Use the provided search box to search for specific material if needed.

15.13.5 If you want you can add selected material to the ‘Favorites’ category using the ‘Add To Favorites’ button.

15.13.6 Once the selection is made click the ‘OK’ button to secure the selection.

15.13.2

15.13.3

15.13.4

15.13.5

15.13.6

15.13.1



109PAGE -15.14 WALL ATTRIBUTES - SHOWN IN 3D

15.14.1 The first view shows the back of the 40 1/2” height wall, but not the angled wall. When a placement zone is placed on the inside 
and outside of a wall, both sides of the wall will show in the 3D view. As the 3D view is rotated walls with only an inside placement zone 
will disappear when viewed from the back and then reappear when viewed from the front. In the example below the 40 1/2” wall doesn’t 
disappear because it has both inside and outside zones.

Training Exercise: Click the ‘3D’ button, rotate the 3D view to see how walls disappear and reappear, and then close the 3D view. Delete 
the Angled Wall and the Right Wall from the design plan view.



110PAGE -15.15 ADDING AN ISLAND

15.15.1 To add an island click on the ‘Construction Line’ button, place the cursor where the island is to start, and left-click to start the 
‘Construction Line’. The length of the island is set in the same way as setting a new wall.

15.15.2 To change the attributes of the island right-click on the construction line, select the construction line, and select ‘Attributes’. 
This brings up the ‘Construction Line Attributes’ window.

15.15.3 Click the radio buttons to change a wall type. Check the ‘Wall Zone’ checkboxes to place placement zones on the inside and/or 
outside of a wall. Use the text boxes or the up/down arrows to change the thickness and/or height of the selected wall.

Training Exercise: Draw an island 72” long, 0” thick with inside and outside construction zones as shown.

15.15.115.15.3



111PAGE -15.16 MOVING THE ISLAND

15.16.1 To move the island section right-click on the Island Construction Line, select ‘Wall Group’, and select ‘Move’. This allows the 
island section to be moved in all directions. Once the section is in the desired location, left-click to set it into place.

Training Exercise: Set the island 66” from the Top Wall and 96” from the Left Wall using the dimension lines.

Note: You can set the dimensions within 1/16” to 1/8” of the actual distances.

15.16.1



112PAGE -15.17 WALL GROUPS

15.17.1 To add a wall to the group, click menu ‘Wall’ > ‘Add to Group’. Then choose from which wall to create a group by clicking on it 
with the mouse. A created group can be moved, dragged, and rotated altogether.

15.17.1



113PAGE -15.18 REMOVE FROM GROUP

15.18.1 In order to remove the wall from the group click menu ‘Wall’ > ‘Delete’.

15.18.1



114PAGE -15.19 FREEFORM WALL OPENINGS

15.19.1 We can create a cutout in the wall or an arch shape and size desired. To do this, in the left panel, select the directory in the Ar-
chitectural Elements list. Choosing ‘Wall Opening’ - ‘FWO’.

15.19.2 Transfer to the wall where the wall opening should be.

15.19.3

15.19.1

15.19.2



115PAGE -15.19 FREEFORM WALL OPENINGS

15.19.3 Edit it by using the menu ‘Elevation’, right-click and choose ‘Edit’. To save the changes click on the white arrow on the top panel.

15.19.3



116PAGE -15.20 DOOR/WINDOW FRAME

15.20.1 To create wall opening you can also use ready-made arches or rectangular cutouts in the ‘Architectural Elements’ in ‘Door/
Window frame’.

15.20.1



117PAGE -15.21 MIRROR

15.21.1 You can mirror a wall or group of walls by clicking on the ribbon panel ‘Draw & Place’ and then selecting ‘Mirror Vertically’ or 
‘’Mirror Horizontally’.

15.21.1



118PAGE -15.22 WALL ZONES ON/OFF

15.22.1 The elevation wall may be on the outside, inside, or on both sides. Right-click on the wall - use the dialog box and in the ‘Wall 
Zone’ fields select the front of the ‘Inside Zone’ or ‘Outside Zone’ (or both). Click ‘OK’.

15.22.1

15.22.1



119PAGE -15.22 WALL ZONES ON/OFF

15.22.2 Click on the wall with the right mouse button and using the dialog box select which side should be displayed - ‘Inside Elevation’ 
or ‘Outside Elevation’.

15.22.2



120PAGE -15.23 INVISIBLE WALL ZONES AND PANELS

15.23.1 In 3D we have the ability to hide the wall and the panel if they interfere with the design view or for rendering.

15.23.1



121PAGE -15.24 MULTI-ROOM DESIGN

15.24.1 ProKitchen allows you to have multiple rooms in your design. Add the interior wall with the ‘Add Wall’ option from the wall right-
click menu.

15.24.2 Each room can have its own name, flooring, ceiling, and wall covering which you can adjust in the ‘Room Attributes’ dialog that 
you can access by right-clicking the grid space within the separate room to launch the menu..

15.24.1

15.24.2



122PAGE -16.1 USER SHAPES

16.1.1 User Shape is used in design when you need to put a different pattern on the part of the wall or the floor, not the same as on a 
common wall. For example, part of the floor is wood or part of the floor is tiled. In order to apply User Shape - in the left panel, select the  
‘Architectural Elements’ catalog, and choose the ‘User Shapes’ folder. Choose ‘Wall’ or ‘Floor User Shapes’ and pull it to the Plan.

16.1.1

16.1.1



123PAGE -16.2 WALL USER SHAPES

16.2.1 Clicking on the plan with the right mouse button on the User Shape will bring in the ‘Attribute’ dialog box. It gives you an oppor-
tunity to move the User Shapes, copy, rotate, lift, or lower, and edit or delete it.

16.2.2 To edit User Shape right click on it and select ‘User Shape’ > ‘ Edit’. This will allow you to stretch the User Shape to the size you 
want by pulling on the points. Right-click on any of the points to access the menu where you can add or move points, round, or cut corners.

16.2.2

16.2.1



124PAGE -16.3 FLOOR USER SHAPES

16.3.1 Edit User Shape is possible by choosing ‘Attributes’ and right-clicking on the User Shape. A window appears, in the ‘General’ tab 
set the desired size, and in the ‘Texture tab’ select the color or texture for the User Shape. Select the ‘As Countertop’ option if you want User 
Shape to receive the countertop color that is already defined in the catalog. If you want it to be wood then select the ‘Select Wood’ option 
and further down press the ‘Select’ button and choose the desired color from the list.

16.3.2 If you want the User Shape to have a  different color or tile, choose the ‘Select Non-Wood’ option and it opens a list with possible 
textures that you can pick from.

16.3.1

16.3.1

16.3.2



125PAGE -17.1 PLACING A WINDOW

17.1.1 Use the ‘Windows’ button to bring up the selection of windows. 17.1.2 To see the available window styles double-click on the 
item category or click the ‘Expand’ button to open the drop-down menu. 17.1.3 To see the available window sizes left-click the windows 
style description. 17.1.4 In the list, scroll with the mouse to choose a window you want. After selecting a window the field with the size of 
this window will appear on the right. Also, you can see the sizes by right-clicking on the window you need.

17.1.5 To place a window highlight the item and click the ‘Place’ button. 17.1.6 Place the cursor in the Placement Zone and click the left 
mouse button. Drag the window to the desired location and left-click to set the window. The Info text box can be used to place the window 
from the left, center, or right. Once the dimension is typed in the text box, press the ‘Enter’ key to set the window.

Note: All windows are set at 30” wide.

17.1.2

17.1.4

17.1.1

17.1.5



126PAGE -17.1 PLACING A WINDOW

17.1.7 Right-click on the window to be resized and select the ‘Window’ from the drop-down menu. Choose the ‘Resize’ option from the 
drop-down menu to change the window width from the right side.

Note: The window can be moved by clicking on the window (turning the outline red) and typing the placement in the edit boxes. The last 
dimension entered is where the window will be placed.

17.1.7



127PAGE -17.2 WINDOW ATTRIBUTES

17.2.1 Choose attributes from the dropdown menu to change the width of the window from the center. The ‘Attributes’ window is also 
used to change the window height.

17.2.1



128PAGE -17.3 ATTRIBUTES - GENERAL TAB

17.3.1 You can set a background which will be shown behind the widow, for this click ‘Select window View’. Opens a folder with the 
available backgrounds, choose the most practical for you, and click ‘Select’. You can upload any image from your computer by selecting 
‘This PC’ in the left panel and navigating to the file you want to use.

17.3.2 In the ‘General’ tab, put down the window size, moving up and down arrows.

17.3.1
17.3.2



129PAGE -17.3 ATTRIBUTES - GENERAL TAB

17.3.3 You can put down the size of each section if they are in the window. For this, right-click the mouse to the desired section and in 
the ‘Section width’/’Section height’ specify the size.

17.3.4 You can select the type and shape of the window on the bottom panel. Right and left arrows on the sides of the list allow you to 
navigate through the list of available window types, by clicking on one of them you will see it in 3D view.

17.3.5 If you want to add the light to the window, click ‘Add Sun Light’.

17.3.3

17.3.3

17.3.5

17.3.4



130PAGE -17.4 ATTRIBUTES - CONSTRUCTION TAB

17.4.1 In the ‘Construction’ tab select ‘Installation’. You can select ‘Jambs and Casing’ or ‘Drywall Returns’. In the same tab, you can 
select a profile for the window. Click on your profile and 3 variants will appear, select the one you want and click ‘OK’.

17.4.2 Right and left arrows on the sides of the list allow you to navigate through the list of available construction designs, by clicking 
on one of them you will see it in 3D view.

17.4.1

17.4.2

17.4.1

17.4.2



131PAGE -17.5 ATTRIBUTES - SPECIAL SHAPES TAB

17.5.1 Select the desired design.

17.5.1

17.5.1



132PAGE -17.5 ATTRIBUTES - SPECIAL SHAPES TAB

17.5.2 At the ‘Special Shapes’ tab, we have the ability to change the shape of the window by using one of the following options: ‘Rec-
tangular’, ‘Round Glass’, ‘Round Top’, ‘Full Arch Head’, or ‘Elliptical’. It is possible to change the height of the arch in the ‘Arch Height’ by 
clicking the up and down arrows in the top right segment of the dialog.

17.5.2



133PAGE -17.6 ATTRIBUTES - GRILLE PATTERNS TAB

17.6.1 In the ‘Grille Patterns’ tab, we can add and select one of the types of rails on the windows, and specify the desired number of rails 
on verticals and horizontals. We can also select the desired profile.

17.6.1



134PAGE -17.7 ATTRIBUTES - WINDOW GLAZING TAB

17.7.1 In the ‘Window’ tab select ‘Glazing Options’ (‘Not Glazed’, ‘Single Glazed’ or ‘Double Glazed’) and ‘Grille Installation’ (‘No Grille’, 
‘Inside Only’, ‘Inside and Outside’ or ‘Between the Glass’).

If you choose ‘Single Glazed’ or ‘Double Glazed’ – at the bottom you can select ‘Clear’, ‘Matte’, ‘White’, or ‘Smoked’.

17.7.1



135PAGE -17.8 ATTRIBUTES - WINDOW INTERIOR TAB

17.8.1 In this field, you choose whether you want a stool & apron, and casing on your window. Select the box opposite ‘Install Stool & 
Apron’ if you want it to be on the window. Right-clicking on the casing will allow you to select the desired shape. It is necessary to choose 
the form of the stool.

17.8.2 Select the ‘Install Casing’ checkbox if you want it to be on the window and then in the field below you can specify its width. In the 
right field click ‘Casing’ and select its shape.

17.8.3 The color of the window you can select at the bottom.

17.8.2

17.8.3

17.8.1



136PAGE -17.9 ATTRIBUTES - WINDOW EXTERIOR TAB

17.9.1 To install the brickmould select the ‘Install Brickmold’ checkbox. Select the brickmould style by clicking on the ‘Brickmould’ op-
tion on the right. At the bottom select the desired color.

17.9.1
17.9.1

17.9.1



137PAGE -17.10 ATTRIBUTES - HARDWARE TAB

17.10.1 You can install or remove the hardware from the window. You just need to place or remove a check mark in the ‘Install Hardware’ 
checkbox.

17.10.2 At the bottom, you can choose the color of the hardware.

17.10.1

17.10.2

17.10.2



138PAGE -17.11 ATTRIBUTES - BLINDS TAB

17.11.1 Also, you can add window blinds (rectangular only). You can select color, width, and tilt position. To install it, go to the ‘Blinds’ 
tab and select the ‘Install Blinds’ checkbox.

17.11.2 In the ‘Slat’ field select the thickness of the blinds. Immediately you can see how it looks like in the 3D preview window.

17.11.3 In the ‘Tilt’ field, with the help of a slider, you can choose how opened or closed the blinds will be. We can raise or lower the blinds 
with the slider bar on the right.

17.11.4 You can select the color of the blinds in the list below.

17.11.2

17.11.4

17.11.3

17.11.1



139PAGE -17.12 ATTRIBUTES - SAVE TO MY WINDOWS

17.12.1 A created window can be saved and applied in this or in a different design. To do this click the ‘Save to my Windows’ button.

17.12.1



140PAGE -17.13 SKYLIGHT WINDOWS

17.13.1 Inside the Architectural Elements catalog, we have a ‘Skylight Windows’ category with dozens of windows for you to choose 
from.

17.13.1



141PAGE -18.1 PLACING A DOOR

18.1.1 Use the ‘Doors’ button to bring up the selection of doors.

18.1.2 To see the available door styles double-click on the item category or click the ‘Expand’ icon to open the drop-down menu.

18.1.3 Once you have selected your door, it will bring up, on the right a tooltip with sizing.

18.1.4 You can also see the size of the door by clicking the right mouse button and selecting the ‘Info’ option from the menu.

18.1.5 To place a door select it and click the ‘Place’ button.

18.1.2

18.1.1

18.1.3

18.1.5



142PAGE -18.1 PLACING A DOOR

18.1.6 Place the cursor in the ‘Placement Zone’ and click the left mouse button. Drag the door to the desired location and left-click to 
set the door. Text boxes at the bottom panel can be used to place the door from the left, center, or right. Once the dimension is typed in the 
text box, press the ‘Enter’ key to set the door.

18.1.6



143PAGE -18.2 DOOR ATTRIBUTES

18.2.1 Click the right mouse button on the door and select the ‘Attributes’. Opens a window in which all door options are visible.

18.2.1



144PAGE -18.3 ATTRIBUTES - GENERAL TAB

18.3.1 In the ‘General’ tab in the ‘Plan Notation’, you can specify the name you want to see for this door on the plan and set the door size 
using the ‘Door Width’ and ‘Door Height’ fields.

18.3.2 In the ‘Section Width’ and ‘Section Height’ fields you can set the size of each section of the door, pointing at it with the mouse in 
the upper left corner of the window.

18.3.3 You can set the size of the rails using corresponding the fields on the right.

18.3.4 Click the ‘Set View’ button (for glass doors only) and select a background for the doors.

18.3.5 At the bottom, you can select the door layout.

18.3.3

18.3.5

18.3.1
18.3.4

18.3.2



145PAGE -18.4 ATTRIBUTES - CONSTRUCTION TAB

18.4.1 In the ‘Construction’ tab choose to install the door frame or not.

18.4.2 Using the ‘Left’ or ‘Right’ options changes the door opening position. This setting is not available for all door designs.

18.4.3 Below we can select the design of the door. Depending on the design there are possible configurations that can be edited.

Opening - with the help of the slider this sets the door opening (for the standard design only);

Section - select the number of sections (Folding);

18.4.2

18.4.3

18.4.1



146PAGE -18.5 ATTRIBUTES - TYPE TAB

18.5.1 In the ‘Type’ tab you can select the type of the door. Depending on the type there are different configurations.

For panel doors, you can change the width and height of the ‘Divider Rails’. For each section, you can set the number of columns and 
rows and select ‘Groove Panel’ by selecting the checkbox. You can set up the ‘Framing’, ‘Edge’, and ‘Pattern’ by clicking on them, and then 
selecting a style in the dialog.

18.5.1



147PAGE -18.5 ATTRIBUTES - TYPE TAB

18.5.2 Choosing the ‘French’ type will make a section of the door glass. You can change the ‘Shape’, ‘Options’, ‘View’, ‘Installation’, and 
‘Patterns’ settings and set the desired number of ‘Columns’ and ‘Rows’. You can set up ‘Grille Pattern’ and ‘Glazing Profile’.

18.5.2



148PAGE -18.5 ATTRIBUTES - TYPE TAB

18.5.3 ‘Louvered’ door type – you can change the width and the height of ‘Divider Rails’. In ‘Sections’, you can change the number of 
‘Columns’ and ‘Rows’. You can choose the ‘Slat Style’. Individual sections can be closed with the panel by selecting the checkbox next to 
the ‘Standard Panel’ option. Also you can set up ‘Slat Profile’, ‘Framing’, and ‘Edge’.

18.5.4 Having chosen a ‘Type Special’ the door becomes flat.

18.5.4

18.5.3



149PAGE -18.6 ATTRIBUTES - DOOR INTERIOR TAB

18.6.1 In ‘Door Interior’ tab choose ‘Jamb Material Extends’ - ‘Interior’ or ‘Exterior’.

18.6.2 ‘Install Casing’ is set by default and if you want to delete it just remove the tick from the checkbox. Use the ‘Casing Width’ field 
to set the width of the casing. 

18.6.2

18.6.1



150PAGE -18.6 ATTRIBUTES - DOOR INTERIOR TAB

18.6.3 Set up the type of the ‘Casing’ by clicking on the image and selecting the type you need from the dialog.

18.6.4 Below you can choose the color for the inside of the door and door frame. Clicking on the desired color will change the color of 
the door in the 3D preview.

18.6.4

18.6.4

18.6.3



151PAGE -18.7 ATTRIBUTES - DOOR EXTERIOR TAB

18.7.1 In the ‘Door Exterior’ tab choose ‘Jamb Material Extends’ - ‘Interior’ or ‘Exterior’.

18.7.2 ‘Install Brickmold’ is set by default and if you want to delete it just remove the tick from the checkbox. You can change the type 
of ‘Brickmould’ by clicking on it and selecting the type you want from the dialog. Use the ‘Brickmold Width’ field to set the width of the 
brickmold.

18.7.3 Below you can choose the color for the inside door and door frame. Clicking on the desired color will change the color of the door 
in the 3D preview.

18.7.2

18.7.1

18.7.2

18.7.3



152PAGE -18.8 ATTRIBUTES - HARDWARE TAB

18.8.1 In the ‘Hardware’ tab you can select the hardware for the doors. To install the door handles select the ‘Install Hardware’ checkbox. 
Use the ‘Finish’ option to change the hardware color from the list - ‘Brass’, ‘Black’, ‘Nickel’, or ‘Black and White. Use the list below to select 
the desired hardware type. After choosing the color and type of handle you can immediately see the changes in 3D.

18.8.1



153PAGE -18.9 ATTRIBUTES - SAVE TO MY DOORS

18.9.1 The door can be saved and applied in this or in a different design. To do this click the ‘Save to My Doors’ button.

18.9.1



154PAGE -19.1 CABINET POP-UP MENU

Training Exercise: Right-click on the right base 18” cabinet and select the B18R in the drop-down menu. This shows the different actions 
that can be done to the selected item. 

Drag - This allows an item to be dragged along the wall or construction line.

Move - This allows the movement of an item from one location to another. Example: Moving a cabinet from the sink wall to the island.

Rotate - This allows an item to be rotated 360° degrees. The angle of the cabinet can be set using the ‘Info’ text box.

45° Clockwise, 45° Counter Clockwise - rotates the cabinets by 45 degrees clockwise or counterclockwise.



155PAGE -19.1 CABINET POP-UP MENU
In/Out - This allows an item to be moved in and out from the wall. The distance from the wall can be set using the ‘Info’ text box.

Up/Down - This allows the movement of a cabinet to be moved up and down along the same vertical alignment. The distance from the 
floor and/or the ceiling can be set using the ‘Info’ text box.

Center - This allows the centering of an item under, above, or onto another item. Example: This function can be used to center a range 
hood directly above a range or center a sink into a sink base, etc.

Position - This allows an item to be positioned at a specific distance away from another item.

Fit - This option is not available for all manufacturers. This allows an item to fit into a space that is smaller in width than the selected 
item. Custom manufacturers that allow width modifications will resize and price automatically.

Snap - This allows an item to be placed tightly with an adjacent item. Example: When placing two windows together a 1-16” space will 
be left. This feature allows them to be snapped together thus deleting the gap.

Stack: This allows an item to be stacked above or below another item. This is available on many cabinets and select appliances.

Nomenclature - cabinet name can be moved and rotated on the plan.

Copy - This allows the copying of an item. If the selected item has any modifications, accessories, etc. they will be copied as well.

Replace - This will allow a cabinet to be replaced with another cabinet without removing the existing cabinet. Example: Changing a B12 
to a 4DB12. If the cabinet that is replacing the other cabinet is larger than the space available it will be placed in the next available space 
at the end of the run of cabinets.

Delete - This allows the removal of an item from the plan. The item can also be deleted by clicking on the item and pressing the ‘Delete’ 
key on the keyboard.

Add To Group - This allows the creation of a group and gives the ability to add an item to a particular group.

Shuffle Wood - This allows to shuffle wood texture on the cabinet.

Change Color - This option changes the color of the cabinet on the Plan/Elevation.

Attributes: This is where all the cabinet modifications, accessories, hinges specifications, finished ends, pricing, plan notation, etc can 
be set and/or changed.
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19.2.1 Right-click on the item to be dragged, click on the item from the drop-down menu then click on the ‘Drag’ option from the second 
drop-down menu. The item will now drag along the plane (wall) that it is placed on until it hits another item. The item can be dragged past 
another item or wall by simply moving the cursor past the other item. Left-click to set the item.

Training Exercise: Drag the B18R along the top wall and set it back into its original position.

19.2.1
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19.3.1 Right-click on the item to be moved, click on the item from the drop-down menu then click on the ‘Move’ option from the second 
drop-down menu. The item can now be moved to another location on the design. The item can be placed inside or outside a placement 
zone. If the item is placed outside a placement zone it will follow the mouse until the left mouse button is clicked. Left-click to set the 
cabinet.

Training Exercise: Move the B18R to the Left Wall and set it next to the Lazy Susan.

19.3.1
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Training Exercise: Move the B18R to a space outside the placement zone, on the grid, and set it into place.

19.4.1 Right-click on the item to be rotated, click on the item from the drop-down menu then click on the ‘Rotate’ option from the second 
drop-down menu. The item can now be rotated to any angle within the area in which it is placed. Left click to set the cabinet.

Training Exercise: Rotate the B18R and set it outside a placement zone.

Note: The cabinet will align with the wall.

19.4.1
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Training Exercise: Turn cabinet to 45° clockwise.

19.5.1 Right-click on the item. In the menu choose ‘45° Clockwise’. The product will turn 45° degrees.

19.5.1
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19.6.1 Right-click on the item to be moved in or out, click on the item from the drop-down menu then click on the ‘In/Out’ option from 
the second drop-down menu. The item can now be moved in and/or out from its original placement. Left click to set the item.

Training Exercise: Pull the Sink Base out 3” from the Top Wall. Place a 24” x 30” Diagonal Wall Corner Cabinet (left hinge) in the corner 
above the Lazy Susan.

19.6.1
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19.7.1 Right-click on the item to be moved up or down, click on the item from the drop-down menu then click on the ‘Up/Down’ option 
from the second drop-down menu. The item can now be moved up and/or down from its original vertical placement.

Note: The direction menu is used for corner and end cabinets only. This menu changes the direction of the cabinet.

Training Exercise: Move the Diagonal Wall Corner Cabinet to 60” off the floor. Place any double bowl under the mount sink into the Sink 
Base cabinet.

19.7.1
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19.8.1 Right-click on the item to be centered, click on the item from the drop-down menu then click on the ‘Center’ option from the sec-
ond drop-down menu. The item can now be centered on another object by clicking on the object to be centered on.

Training Exercise: Center the sink on the Sink Base Cabinet, pull the sink forward from the wall, and place a single-hole kitchen faucet 
on the countertop behind the sink. Place a B33 anywhere on the Left Wall.

19.8.1
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19.9.1 Right-click on the item to be positioned, click on the item from the drop-down menu then click on the ‘Position’ option from the 
second drop-down menu. The item can now be positioned at a specific distance from another object. Click on the object that the selected 
item is to be positioned from and enter the distance in the ‘Info’ panel text boxes and press the ‘Enter’ key.

Training Exercise: Position the B33 18” from the left of the Lazy Susan.

19.9.1
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19.10.1 Placing a larger item in a smaller space will cause a collision detection message to appear. This collision message is designed 
to inform the user that the space is too small for the selected item. To fit the item, right-click on the item to be fitted, click on the item from 
the drop-down menu and click on the ‘Fit’ option from the second drop-down menu. The item can now fit into the space by clicking back 
into that space. If the manufacturer allows width modifications the item will be resized to fit in the space. If the manufacturer does not 
allow width modifications the collision message will appear again. This indicates that the cabinet will not fit and a smaller cabinet needs 
to be selected for the space.

Training Exercise: Place a B18R between the Lazy Susan and the B33, and use the ‘Fit’ option if necessary.

19.10.1
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Training Exercise: Drag the B18R on the top wall next to the return wall on the right.

19.11.1 Right-click on the item to be snapped, click on the item from the drop-down menu then click on the ‘Snap’ option from the sec-
ond drop-down menu. The item can now be snapped to the adjacent item by clicking on the adjacent item.

Training Exercise: Snap the B18R to the 18” Drawer Base Cabinet on the Top Wall.

19.11.1
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19.12.1 Right-click on the item to be copied, click on the item from the drop-down menu then click on the ‘Copy’ option from the second 
drop-down menu. The item is now copied and can be placed into any placement zone or anywhere in the design.

Training Exercise: Copy the B18R to the island as shown above.

19.12.1
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This option is used to replace a cabinet with a different cabinet. Cabinets can be replaced with any sized cabinet from the same manu-
facturer. If the cabinet being changed is larger it will be placed in the next available space or at the end of the cabinet run.

19.13.1 Right-click on the item to be replaced, click on the item from the drop-down menu then click on the ‘Replace’ option from the 
second drop-down menu. The ‘Replace Product’ window will appear.

19.13.1
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19.13.2 Use the drop-down menu to change the catalog (if necessary). Use the search bar to find an item by SKU, description, or both. 
Type in the text box and click the find button or press the ‘Enter’ key. A list of items appears in the window below. Highlight the new item 
and click the ‘Replace’ button or double-click on the description. This replaces the item.

Training Exercise: Replace the B18R on the island with an 18” Three-Drawer Base Cabinet.

Note: Use the ‘Info’ button for the information window about the selected product.

19.13.2
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There are two ways to delete an item.

19.14.1 Right-click on the item to be deleted, click on the item from the drop-down menu then click on the ‘Delete’ option from the sec-
ond drop-down menu to delete the selected item. Click on the cabinet to be deleted. The item will show up with red lines. Press the ‘Delete’ 
key to delete the cabinet.

Training Exercise: Delete the 24” Diagonal Corner Cabinet using either method.

19.14.1
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19.15.1 You can move the description of the item on the plan by right-clicking on the mouse.

Choose ‘Nomenclature’ > ‘Move’ or ‘Rotate’. By clicking ‘Move’ SKU is moving and you can display it to the desired location. Clicking 
‘Rotate’ the description will rotate as you manage it with the mouse. To return the description in its place click ‘Nomenclature’ > ‘Default’.

19.15.1
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The ‘Attributes’ window allows access to the general information window about the item, allows accessories to be added, and allows 
modifications to be made to the selected item.

20.1.1 To show the ‘Attributes’ of an item, right-click on the item, select the item from the drop-down menu then click on the ‘Attributes’ 
option from the second drop-down menu.

Training Exercise: Bring up the ‘Attributes’ window for the B18R on the top wall.

20.1.1
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20.2.1 The ‘General’ tab of the ‘Attributes’ window shows the general information for the selected item. Each manufacturer will have 
different information in the ‘Attributes’ window. Some of the following information may be different or may not be available with select 
manufacturers.

20.2.1
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The ‘Modifications’ tab shows the available modifications for the selected manufacturer. Each manufacturer will have different informa-
tion and items available. Some of the following information may not be available with your manufacturer.

20.3.1 Use the ‘Modifications’ tab to select the modification category.

20.3.2 Clicking the arrow to the right will add the selected modification to the product, and clicking the arrow to the left will remove it. 
When you click the double arrow all modifications will be removed from the product.

20.3.3 There are two buttons at the bottom. ‘Expand All’ - opens all categories and you will see all available modifications. ‘Collapse 
All’ - all opened categories will be closed.

Training Exercise: Add the ‘Remove Doors’ modification to the cabinet and then remove the modification.

20.3.1

20.3.2

20.3.3
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The ‘Accessories’ tab shows the available accessories for the selected manufacturer. Each manufacturer will have different information 
and items available. Some of the following information may not be available with your manufacturer.

20.4.1 Use the ‘Accessories’ tab to select the accessory category.

20.4.2 Click on the desired accessory. The image of it will appear to the right and you will see how it looks. Clicking the arrow to the right 
will add the selected accessory to the product, and clicking the arrow to the left will remove it. When you click the double arrow all added 
accessories will be removed.

20.4.3 There are two buttons at the bottom. ‘Expand All’ - opens all categories and you will see all available accessories. ‘Collapse All’ 
- all opened categories will be closed.

Training Exercise: Add an accessory to the cabinet.

20.4.1

20.4.2

20.4.3
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20.5.1 In the ‘Sinks and Faucets’ tab, you can add a sink and faucet and it will automatically install to the cabinet. To do this, choose a 
sink or faucet adapted for the appropriate cabinet.

20.5.2 Using the drop-down menu at the top left you can choose which catalog you want to use for the sink and faucet. Available default 
Plumbing catalog or if you have Kohler catalog it will also be offered in the list. Next, open the desired category.

20.5.1
20.5.2
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20.5.3 Clicking with the mouse on the products there will appear a window with its description and size. When you choose the sink or 
faucet click on the arrow to the right and the product will automatically install. By clicking on the arrow to left you will remove the product 
from the cabinet. By clicking on the double arrow to the cabinet all added products would be removed.

20.5.4 There are two buttons at the bottom. ‘Expand All’ - opens all categories and you will see all available sinks and faucets. ‘Collapse 
All’ - all opened categories will be closed.

Training Exercise: Add a sink and a faucet to the cabinet.

20.5.4

20.5.3
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20.6.1 You can add lighting to the cabinet in this tab.

20.6.2 Open the folder with the available lights. Hovering your mouse over them you’ll see a preview image. After selecting a light, click 
on the arrow to the right to add the selected light to the cabinet. See it by opening the cabinet door. Clicking on the ‘Duplicate’ icon will 
make a copy of the selected light.

Training Exercise: Add lighting to the cabinet.

20.6.1

20.6.2
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20.7.1 In this tab, you can adjust the placement of the hardware on the doors, or even remove them.

20.7.2 To change the position of the hardware just click with the mouse on the right side of the window and then you can change the 
position of the hardware, move it vertically or horizontally, moving the circle with the mouse selecting the ‘Top’, ‘Center’, ‘Bottom’.

20.7.3 If you don’t want hardware to appear unselect the ‘Display Hardware’ checkbox.

20.7.1

20.7.3

20.7.2
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21.1.1 You can fully customize hoods in the ‘Adelphi Kitchens’ catalog.

21.1.1
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21.2.1 In the ‘Modifications’ tab of the ‘Attributes’ window in the left panel, there is a list of available hood modifications.

21.2.2 You can add multiple modifications for the same product.

21.2.1 Each modification can be edited, to change the available options for this modification.

21.2.1

21.2.2

21.2.3
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22.1.1 To install the sink or faucet click the ‘Plumbing’ icon in the ribbon panel and in the open window you will see the available cata-
logs, options for a sink, faucet, bath, and so on. Select the product you need and drag it to the desired cabinet. The sink and faucet will be 
automatically placed at the correct height. Place the sink only in designated cabinets.

In the upper part of the window are located categories. Select the desired catalog and you will see the products at the bottom. Click with 
your mouse on the product and on the right you will see a 3D image. You can see its ‘Info’ by right-clicking on the product. This opens a 
window where you will see the product description and size.

You can also set the sink and faucet through the attribute dialog, as described in 19.5 paragraph.

22.1.1
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22.1.2 Once the product is added to the plan you can edit, move, or turn it. Available in all the same steps as for cabinets. By right-click-
ing on the product, select ‘Attributes’. In the opened window in the ‘General’ tab, you can edit the size.

22.1.2
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22.1.3 In the ‘Texture’ tab (not available for all cabinets) you can select one from the textures list. By clicking on a specific color the 
product will immediately change its color in the 3D window on the right and you can see how it looks in the design.

To save the selected settings, click ‘OK’.

22.1.3



184PAGE -22.2 SWITCH SKU FOR BUILT-IN SINKS & FAUCETS

When using the ‘Switch SKU’ the built-in sinks and faucets will be installed in the switched cabinet if it is an appropriate size. If the size 
of the sink or the faucet is greater than the cabinet, then it will not place in the cabinet, and at the completion of the Switch SKU operation, 
a message will be displayed stating which items were removed from the cabinet due to a mismatch in dimensions.
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22.3.1 The ‘Appliance tab’ in the cabinet ‘Attributes’ window, is available on all cabinets that can have an appliance placed into them.

22.3.2 Use these text boxes to set the height, width, and distance of the appliance cut-out from the floor.

22.3.3 Use the ‘+’ and ‘-’ buttons to increase/decrease the size of the picture in the cabinet window.

22.3.4 Once the cut-out dimensions are set click the ‘Add Appliance’ button to add the appliance to the cabinet.

22.3.5 Select the appliance to be placed into the cabinet using the appliance window as discussed. Choose an appliance that is close 
to the actual one. The dimensions can be changed in the next step.

22.3.6 Once the appliance is placed into the cabinet, the dimensions can be changed using the provided text boxes and/or arrows.

22.3.7 Once the appliance is set click the ‘OK’ button.

22.3.1

22.3.322.3.5

22.3.2
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The design can have multiple textures for cabinets in one catalog. To implement this make a copy of the catalog and select other options 
for those products which you want to change color.

There are two variants to copying the catalog.

23.1.1 If you want to change the color of cabinets that already exist on the plan right-click on it and choose ‘Change Color’ > ‘Create 
Catalog Copy’. In the new window name the newly created catalog.

23.1.1
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23.1.2 Click ‘OK’ and the program immediately prompts you to select options for this product in the new catalog. After selecting ‘YES’ 
you can choose the options you need in the new window. After choosing ‘NO’ the window won’t appear. To select options you can click the 
‘Option’ button and choose a new catalog. Moreover, this catalog would appear in the catalog list. All the products you choose will have 
options applied to the new catalog.

23.1.3 Running 3D you will see that the cabinet has changed color.

23.1.3
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If there are no products on the plan that should differ in options you can copy the catalog in another way. 

23.2.1 On the ribbon panel click ‘Catalog & Solutions’ > ‘Copy Catalog’. The program will offer to save a design, click ‘OK’, the design will 
be closed and you will see the list of catalogs.

23.2.2 Select the catalog, the copy of which you want to do, and click ‘Copy’. Fill in ‘Catalog Name’, for example, ‘Prokitchen Catalog 2’, 
and click ‘OK’.

23.2.2

23.2.1
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23.2.3 Open the design and see the new catalog ‘Prokitchen Catalog 2’ in the list. Select options, a new catalog, and add new options 
for it.

23.2.3



190PAGE -24.1 SEARCH TOOLS - FIND CUSTOMER

24.1.1 Use the ‘Customer Search’ button to access the ‘Customer Search’ window.

24.1.2 Type specific information in the text box.

24.1.3 Select the search method.

24.1.4 If the name is found with the entered information it will appear in the ‘Search Result’ window. Click on the customer’s name to 
access the plan(s) for the customer.

24.1.5 The ‘Edit’ and ‘Delete’ buttons are used to edit or delete customer information.

Training Exercise: Familiarize yourself with the ‘Customer Search’ feature.

24.1.1

24.1.3

24.1.2

24.1.4

24.1.5
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24.2.1 Use the ‘Search’ tab in the ribbon panel if you need to find something.

24.2.2 Type specific information in the text box.

24.2.3 Select the button in which the search is to be searched. Search by ‘Order Number’, ‘Job Name’, ‘Contract #’, ‘P.O. #’, ‘Status’, ‘Cus-
tomer’ and ‘Date Range’. If searching by date range click the first ‘Calendar’ button and set the first date then click the second ‘Calendar’ 
button to set the second date. The program will bring up all designs between these dates. If the name is found with the entered information 
it will appear in the ‘Search Result’ window. Click on the customer’s name to access the plan(s) for the customer.

Training Exercise: Familiarize yourself with the ‘Search Design’ feature.

24.2.3

24.2.1
24.2.2
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25.1 At the bottom right of the screen located the ‘Snap Bar’. The panel includes the following switches:

GRID (Show Grid) - show grid (on/off); ZONE (Show Wall Zones) - enabling/disabling the wall trapping zone; MDIM (Display Distances 
on Mouse Navigation) - display size at the point of moving the mouse (on/off); SNAP (Cabinet Snap) - enable sticking mode at moving 
products and walls (on/off); GSNAP (Grid Snap) - linking displacement product to the grid (on/off); COL (Collision Detection) - avoid col-
lisions mode (on/off)

On the switch SNAP right click for the pop-up menu with a choice of sticking elements:

Endpoint - corners elements; Midpoint - midpoints of elements; Nearest - the nearest distance between the point and the side of ele-
ments.

25.1
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26.1.1 Go to the catalog ‘Lightning’, in the ribbon panel, to add lightning or chandeliers to your room. Choose which lighting you need, 
the items are in the folder. In the right part of the dialog, you can see the image of it. When you have chosen the chandelier or spotlights 
drag it to the plan by clicking the ‘Place’ button.

When all lightning is chosen click ‘Cancel’ to close the window.

26.1.1
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26.2.1 The lighting can be added inside of the cabinet. Right-click on the cabinet and select attributes. Open the folder with available 
lights. Select your lighting. Click on the arrow to the right and the light will be added inside the cabinet. Open the door to see it. Click the 
‘Duplicate’ and the light will be copied. To do this click on the light you want to duplicate. To delete unnecessary light, click on it and click 
on the left arrow. You will see in the description area where the light is removed.

26.2.1
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26.3.1 Right-clicking on the light source will open a window - the light source can be moved, raised and lowered, centered, copied, or 
turned off.

26.3.2 In ‘Attributes’, you can edit the power of the light by moving the slider.

26.3.3 In the ‘Color’ field, you can choose the color of the light. Click ‘Select’ and you will see the palette. Choose the desired color and 
click ‘OK’.

26.3.1

26.3.2

26.3.3

26.3.3
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26.4.1 Sun Lighting can be added automatically through the window. Click ‘Add Sun Lighting’ in the ‘Attributes’ dialog box.

26.4.1
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27.1.1 To auto-build, the Countertop click the ‘Add All’ button from the ‘Ctops & Moldings’ tab on the ribbon panel.

27.1.1
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A countertop can be edited. Right-click on it and you will see the drop-down menu.

27.2.1 Drag - Right-click on the countertop to be dragged, click on the ‘Countertop’ from the drop-down menu then click on the ‘Drag’ 
option from the second drop-down menu. Left-click to set the countertop. 

27.2.2 Move - Right-click on the countertop to be moved, click on the ‘Countertop’ from the drop-down menu then click on the ‘Move’ 
option. The countertop can now be moved to another location on the design. Left-click to set the countertop.

27.2.3 Rotate - Right-click on the countertop to be rotated, click on the ‘Countertop’ from the drop-down menu then click on the ‘Rotate’ 
option. The countertop can now be rotated to any angle within the area in which it is placed. Left-click to set the countertop.

27.2.4 In/Out - Right-click on the countertop to be moved in or out, click on the ‘Countertop’ from the drop-down menu then click on the 
‘In/Out’ option. The countertop can now be moved in and/or out from its original placement. Left-click to set the countertop.

27.2.2
27.2.4

27.2.1
27.2.3
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27.2.5 Up/Down - Right-click on the countertop to be moved up or down, click on the ‘Countertop’ from the drop-down menu then click 
on the ‘Up/Down’ option from the second drop-down menu. The countertop can now be moved up and/or down from its original vertical 
placement. Use the text boxes in the ‘Info’ panel to set the distance from the bottom of the item to the floor or from the top of the item to 
the ceiling. Once the dimensions are entered press the ‘Enter’ key. This will set the item to the entered height.

27.2.6 Copy - Right-click on the countertop to be copied, click on the ‘Countertop’ from the drop-down menu then click on the ‘Copy’ 
option from the second drop-down menu. The countertop is now copied and can be placed into any placement zone or anywhere in the 
design.

27.2.7 Delete - Right-click on the countertop to be deleted, click on the item from the drop-down menu then click on the ‘Delete’ option 
from the second drop-down menu to delete the countertop.

27.2.6 27.2.5
27.2.7
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27.2.8 Right-click on the countertop to edit it. On the edge of the countertop appears red circles, pulling them you can change the shape 
and size of the countertop. We can make the cut-out by right-clicking on the area where we want to make it and selecting ‘Extrude’.

27.2.9 You can move a part of the countertop by right-clicking on the red edge and selecting ‘Intersect’.

27.2.10 You can add one more point for shape-changing by right-clicking on the edge of the countertop and selecting ‘Add Point’.

27.2.11 In order to round the countertop choose ‘Radius End’ and drag the edge of the tabletop to the desired size. If you right-click on 
the circle it will open another menu where the same editing process can be done: ‘Delete Point’ - delete a point; ‘Move’ - a point would be 
placed in the specified location; ‘Bevel’ - cuts the corner at a 45-degree angle; ‘Notch’ - cuts a rectangular segment. To save all settings 
and exit the edit mode you need to click on the white arrow on the top panel.

27.2.10

27.2.8

27.2.11

27.2.9
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You can access the ‘Countertop Designer’ dialog using one of two methods: 

- By right-clicking on the countertop and selecting the ‘Countertop Designer’ option.

- By clicking on the corresponding button in the ‘Ctops & Moldings’ tab of the ribbon panel.

In the opened window we can change and edit the countertop, change angles, cut, profiles, add a sink, and so on.

27.3.1 Shapes - select the shape of any form that is represented in the top part of the window. Pull the slider to the left or right to see all 
proposed variations. Choose the appropriate shape and click on it with the mouse, it will transfer to the countertop, one more click in the 
correct location and it will place. In the left part of the window, you can set the sizes of sections.

27.3.1
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27.3.2 In the ‘Corners’ tab, you can change the countertop corners. Select the edge that is represented in the top part of the window and 
select the corners on the countertop where the selection is to be applied. Click with the mouse on the corners and they will take the form 
chosen. You can edit the size in the lower left panel.

27.3.2
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27.3.3 ‘Segments’ - in this tab, you can add/or cut a segment on the countertop. On the top of the window select the desired segment 
by clicking on it with the mouse then select the countertop by moving the mouse to where it should be placed (it can be moved) and it will 
show the placement location, when the segment is at the desired location, click the left mouse button.

In the left panel is a dialog box where you can specify the size of the segment, set the angle and radius, and set the off-set - right, left, 
or center.

27.3.3
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27.3.4 ‘Cutouts’ - in this tab are cutouts for countertops. Choose the desired cutout by right-clicking on it and then clicking the left but-
ton and its outline will appear on the countertop. Select where the cutout should be placed. In the left part of the window, you can edit and 
move the cutout. To delete added element click ‘X’ icon at the top toolbar.

27.3.4
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27.3.5 ‘Edge Profiles’ - in this tab, you can select the edge for the countertop. Choose the desired profile by moving the slider. After se-
lecting the profile, select with the mouse the edge of the countertop where it should be applied (it would be designated with green color).

By clicking the mouse on the light green you can add or remove edges.

27.3.5
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27.3.6 ‘Material’ - in this tab, you can select a material for countertops. Click in the upper part of the window, select the material or create 
a new one by clicking ‘Add material’, and in the resulting window name your material. In the left panel, under the ‘Image’ press the ‘Select’ 
button, and in the opened window select a material from the list and click ‘OK’ (you can also set its price and thickness). Select ‘Apply’ and 
click on the countertop or part of it - the material will be applied to the countertop. The material can be imported by clicking ‘Import’ > ‘User 
Collection’ a window where you can take desired texture previously added.

27.3.6
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27.3.7 ‘CNC Radius’ - in this tab, you can add a CNC radius. Click on the ‘Add CNC Radius’ button in the left pane and select the size. By 
clicking ‘Add to All’ the CNC radius will be added to all the corners. Corners are denoted with circles. In the ‘Elements’ box select the radius. 
You can change it by clicking on it and using the up and down arrows, or delete the radius by clicking on the black cross. To remove all an-
gles click ‘Delete All’. To add a CNC radius, not to all but to a certain corner click on the ‘Add CNC Radius’ button and enter the desired size.

27.3.7
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27.3.8 ‘European Miter’ - adds a seam between the tops, at the 90-degree corner.

27.3.8
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27.3.9 ‘Backsplash’ - in this tab, you can add a backsplash. Click ‘Add Backsplash’ and then appears a light green dot with a red outline 
of the backsplash, then specify which part of the countertops you want to add it to. In the left panel, set the desired sizes. Clicking on the 
white arrow at the top of the screen and the backsplash will be fixed. To delete individual elements from the backsplash go to the ‘Element’ 
field and click from one element to another, these elements will be highlighted on the countertop. Select the desired element and click the 
‘X’ icon in the top toolbar and the element will be removed.

27.3.9
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27.3.10 ‘Sinks’ - in this tab the sink can be installed on the countertop. To do this, click on the ‘Add Sink’, and in the opened window 
select the product you want, and then click ‘Place’, select with the mouse where it needs to be placed.

27.3.10
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27.3.11 In the ‘Appliances’ tab, you can install appliances on the countertop. Click on ‘Add Appliance’ and in the opened window select 
the desired product and click ‘Place’, select with the mouse where it needs to be placed.

27.3.11
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27.3.12 ‘Default Price’ - this tab contains default prices for different countertop elements, that can be changed.

27.3.12
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27.3.13 ‘BOM’ - in this tab, you will see a list of all modifications applied with the dimensions. In the left panel, you can set the price for 
each of them.

27.3.13
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27.3.14 ‘Place on Design’ - this tab allows you to move and arrange countertops across your design.

27.3.14



215PAGE -27.3 COUNTERTOP DESIGNER

27.3.15 ‘Report’ - you can save and print created countertops by clicking ‘Export PDF’. You can make ‘CNC Integration’ and you can print 
by clicking ‘Print’.

27.3.15
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27.4.1 Right-click on a countertop, and choose ‘Attributes’. In the ‘General’ tab, you can change the width, height, and depth of the coun-
tertop.

27.4.1
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27.4.2 In the second tab ‘Texture’ you can choose a texture for your countertop.

Automatically it is set to ‘Default’. It means that all countertops would have one texture as has been chosen in ‘Design Settings’. If you 
want to change the texture click ‘Special’ > ‘Select’. You will see a new window with textures.  Select the one you need and click ‘OK’. Then 
click ‘OK’ again to close the window.

27.4.2
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27.5.1 To add/remove backsplash(es) click on the ‘Ctops & Moldings’ tab on the ribbon panel. Select ‘Add All’ and it will set around the 
perimeter of the countertops.

27.5.1
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27.5.2 Click the right mouse on a backsplash to access the drop-down menu with the available actions.

27.5.3 Clicking ‘Attributes’ would open a new window. In the ‘General’ tab, you can change width, depth, and height. In the ‘Texture’ tab 
you can select a texture for the backsplash. There are 5 options: 

1. ‘Select Wood’ - click ‘Select’ and choose from the offered wood textures.

2. ‘Select Non-Wood’ - click ‘Select’ and choose from the offered textures.

3. ‘Match Catalog’ - Backsplash would take the color of the cabinet.

4. ‘As Countertop’ - Backsplash would take countertop color. 

5. ‘Default’ - Returns default settings.

27.5.3

27.5.2



220PAGE -28.1 PLACING MOLDINGS

28.1.1 To place the molding(s) that were selected in the ‘Design Settings’ click on the ‘Ctop & Moldings’ tab in the ribbon panel and click 
on the ‘Add All’ button. The selected moldings will be placed into the design.

28.1.1
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28.1.2 To stack moldings select the first molding from the drop-down list (typically a sub-crown or an L-Shape Molding). Drag and drop 
the molding to the top of the cabinet in which it is to be placed. If cabinets are at different levels the molding will need to be placed onto 
each level. The next molding is placed in the same manner and will be stacked onto the first molding.

Note: Moldings are placed on the open sides of cabinets and counted in the exact linear footage. Add additional moldings in the ‘Bill Of 
Materials’ for waste and miscuts. See the ‘Countertop’ section for editing moldings. Moldings are modified similarly to countertops.

28.1.2
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28.2.1 Molding can be edited by clicking the right mouse button. In the menu are the following options: ‘Drag’, ‘Move’, ‘Rotate’, ‘Up/
Down’, ‘Replace’, ‘Delete’, and ‘Change Color’ (as for the cabinets).

28.2.1
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28.2.2 When you select the ‘Edit’ option - molding can be moved by pulling the red circle, you can change its shape, stretch, or move. By 
right-clicking on the red area of molding, the program will offer 4 types of changes: ‘Extrude’ - add a point, which would make the notch. 
You can move the molding by right-clicking on the red box and selecting ‘Intersect’. By right-clicking on the molding and selecting ‘Add 
Point’ you can add one more point if it is necessary for form changing. You can round off the selected molding by selecting ‘Radius End’ 
and dragging the edge of the molding to the desired size.

If you want to make part of the molding invisible after selecting ‘Edit’ right-click on the right location and select ‘Disable’. The part that 
is not visible in 3D would be shown by the dotted line on the plan. To save your changes and exit the edit mode, you need to click on the 
white arrow on the top panel.

28.2.2
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28.2.3 If you right-click on the circle it will open up another menu that also works with editing:

Delete Point - the selected point will be deleted;

Move - a point will be moved to the specified location;

Bevel - cuts the corner at a 45-degree angle;

Notch - cuts a rectangular segment.

28.2.3
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29.1.1 Click the ‘Zoom In/Out’ button to move the design in and out. Left-click on the Plan/Elevation to zoom in, and right-click to zoom 
out.

29.1.2 Click the ‘Zoom Into Region’ button to zoom into a select region. Left-click on the Plan/Elevation and drag the mouse to draw the 
Zoom-In region, left-click again to end drawing the Zoom-In region.

29.1.3 Click the ‘Zoom To Fit’ button to fit the plan to the current Plan/Elevation window.

29.1.4 Click the ‘Select’ button to exit any of the zoom modes.

Note: Use the center mouse wheel to zoom in and out. Hold the center mouse wheel down as a button to move the floor-plan view.

29.1.3

29.1.229.1.1

29.1.4
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30.1.1 Use the ‘Bill Of Materials’ button to access the Bill Of Materials panel.

30.1.2 There are three tabs in the BOM panel. ‘Plan Items’ are items that show in the floor plan, elevations, and 3D view. ‘Non-Plan Items’ 
are items such as extra moldings, panels, extra cabinets, toe kick covers, and items that do not appear on the floor plan, elevations, or in the 
3D view, but will be included in the reports. ‘Additional Products’ are items that have been previously quoted by the manufacturer (special 
orders) or other products that are to be included in the Customer Reports.

30.1.3 There are eleven buttons located within the BOM panel. These buttons are for: Information about the selected item, Deleting an 
item from the BOM (this will also remove it from the plan), Editing an item, Copying an item, Replacing an item, Moving items up and down 
in the BOM list, and Numbering the items on the floor plan.

30.1.1

30.1.2

30.1.3
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30.2.1 Use the ‘Info’ button to display information about an item. Highlight the item and click the ‘Info’ button or double-click the item.

30.2.2 Use the ‘Delete’ button to delete an item. Highlight the item and click the ‘Delete’ button.

Note: This also deletes the item from the design plan.

30.2.3 Use the ‘Edit’ button to edit an item. Highlight the item and click the ‘Edit’ button. This brings up the ‘Attributes’ window. 30.2.4 
Use the ‘Copy’ button to copy an item. Highlight the item and click the ‘Copy’ button. Place the copied item into the design. 30.2.5 Use the 
‘Replace’ button to replace an item. Highlight the item and click the ‘Replace’ button to bring up the ‘Replace’ window. 30.2.6 Use the ‘Up’ 
button to move items up in the BOM list. This will change the cabinet number on the plan. 30.2.7 Use the ‘Down’ button to move items 
down in the BOM list. This will change the cabinet number on the plan. 30.2.8 Use the ‘Display Labels’ button to number the cabinets on 
the design. This places the BOM numbers on the design.

30.2.1
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The ‘Non-Plan Items’ tab utilizes the same buttons as the ‘Plan Items’ tab.

30.3.1 Click on the ‘Non-Plan Items’ tab to access the ‘Non-Plan Items’ window.

30.3.2 Use the catalog window to access the Non-Plan Items. Once an item is selected, drag and drop the item into the Non-Plan items 
window. This will place the selected item into the reports.

30.3.3 To change the quantity of the selected item(s) double-click the item to bring up the ‘Attributes’ window. Use the provided text box 
to set the new quantity for the item(s).

30.3.1

30.3.2

30.3.3
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The ‘Additional Products’ tab is used for items that have been previously quoted from the factory or items that are to be added to the 
customer report such as; countertops, construction, sinks, faucets, appliances, etc.

30.4.1 Use the ‘Additional Products’ tab to access the factory quoted items and additional products window.

30.4.2 Use the ‘Add New Factory Quote’ button to access the factory quoted items and additional products window.

30.4.3 To place a factory quote item or an additional product select the manufacturer’s catalog or ‘My Products’, set the quantity, type 
in a brief description, and type in the quote number (or SKU number for Additional Products) provided by the manufacturer, set the list price 
and type in any notes for the item then click the ‘OK’ button. This will place the item into the ‘Additional Products’ tab.

30.4.1

30.4.3

30.4.2
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31.1 Access the different dimension types by using the ‘Measurements’ drop-down menu or using the ‘Measurements’ buttons:

- Use the ‘Horizontal’ button to show a dimension between two horizontal points.

- Use the ‘Vertical’ button to show a dimension between two vertical points.

- Use the ‘Point-To-Point’ button to show a dimension from a point and another point.

- Use the ‘Multidim’ button to show a dimension between multiple points.

- Use the ‘Point To Line’ button to show a dimension between a line and point.

- Use the ‘Line To Line’ button to show a dimension between two adjacent lines.

- Use the ‘Angular’ button to show the angle between two points.

31.1
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ProKitchen has many different architectural elements such as baseboards, crown moldings, etc. There are also decorative items, furni-
ture, and lighting fixtures that can be placed into the design. Using these elements creates a more realistic view in 3D.

32.1 The decorative items and architectural elements are found in the ‘Catalog’ panel or by using the ‘Lighting’, ‘Furniture’, or ‘Decorative 
items’ buttons on the ribbon panel. They are placed into the plan in the same manner as other items.

Note: Many decorative items are set at kitchen countertop height. Many light fixtures are set at 96” high, so if the ceiling is higher they 
may need to be raised. Most furniture items are set at floor level. Always check the height placement of decorative items.

32.3.1

32.3.1
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32.2.1 Catalog ‘Rev-a-shelf’ - is a catalog with a variety of accessories that you can use in design. It is located on the left side of the list 
of catalogs. It includes various accessories for inside cabinets for the kitchen and bath.

32.2.1
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32.3.1 In the catalog, you will find a variety of furniture for your designs. The catalog is in the left panel, all the furniture is divided into 
categories. You can also access it using the ‘Furniture’ button from the ribbon panel. Select the desired item and drag it onto the plan. You 
can edit, rotate and move it by right-clicking on the product.

32.3.1

32.3.1
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32.4.1 The ‘Closet Catalog’ is designed to create a wardrobe or a separate compilation of furniture. The catalog consists of individual 
partitions, shelves, panels, and so on. The catalog can be installed in the left panel. 

32.4.2 Designing closets. All the closet edits are done on the elevation window where only the closet with its components is shown 
without any other plan items. At one time user can work with only one closet run along one wall. Modules are added to the closet from left 
to right. When adding a new module alongside the existing one the center panel (drilled through) should be inserted between them. In other 
words, when adding or deleting modules the vertical panels have to be altered as well. You can start building a new closet in 3 different 
ways: a) select a system template from the ‘Design Ideas’; b) drag modules (towers) from the catalog window (on the left panel); c) build 
a completely new closet from the ‘Closet Catalog’ items (vertical panels, shelves, etc) by first adding vertical panels and then inserting all 
other closet components and accessories.
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32.4.3 ProKitchen ‘Global Options’ applies to the closet in the same way as they applied for other plan items (e.g. cabinetry).

- All the modules and individual components of the closet are listed in the BOM;

- BOM contains all the hardware needed for closet installation;

This can be achieved by manually adding these items to the non-plan section or automatically by extending the behavior and properties 
of each closet component so we can figure out which hardware we need to combine components between each other.

32.4.4 To create the closet section select the wall on which you want to create it, and click the ‘Closet Designer’ icon on the ribbon panel.

32.4.1

32.4.4
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32.4.5 Opens a window in which you will create a closet. The first tab ‘Closet’ is an information tab, set the size of the wall that you have 
chosen to create a closet. In the ‘Actions’ you can specify how to arrange the section - ‘Place at Wall’, ‘Align Left’, ‘Align Right’, ‘Set Margin’, 
‘Add Molding’. Put a check in the ‘Sync Plan’ to display builds on the plan. If you do not need to remove the check mark.

32.4.6 In the tab ‘Default’ - sets the size of the section, and select ‘Mounting - Floor’ or ‘Wall Standing’. Put a tick in the ‘Add Shelves’ at 
the top and bottom if you want to set the shelf on the top and bottom. In the ‘Count of Section’ select the number of sections of the selected 
size. Next, specify the field where construction ‘Before’ or ‘After’ should be placed. If you have finished a section you must specify with the 
mouse and click before or after it where the next sections should be built. When the section sizes are chosen, click on the green plus sign 
on the installation section of the plan. You can remove sections by clicking on the red ‘X’.

32.4.5

32.4.6
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32.4.7 In the ‘Section’ tab - are the size and description of the section. In the ‘Actions’ - you can add or remove the right or left panel, 
raise or lower a section, change the width, add a corner section, or bridge to another closet.

32.4.7
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32.4.8 In the ‘Doors’ tab, you can add a door to the closet. In the field doors - choose a door from the directory and use ‘Hinges’ to select 
‘L’, ‘R’, or ‘Pair’. In the ‘Level’ field select the level at the top or bottom to set the door. Referring to the section click the ‘Add door(s)’ button 
for the door(s) to be added.

32.4.8
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32.4.9 In the ‘Shelving’ tab you can add shelves. In the ‘Shelves’ field select the type of shelves. In the ‘Count’ field - the number is add-
ed to the section. When choosing shelves they accommodate proportionally. In the ‘Place’ choose where to install the shelf at the bottom, 
top, or on the entire section. You can set the interval with which the shelves are set into the section. By putting a check in the ‘Add dividers’ 
they would appear on the shelves. In the ‘Dividers’ choose from the catalog and in the ‘Count’ field you need to put the number of dividers. 
Click ‘Replicate’ and shelves will be set in sections. If you want to add ‘Dividers’ specify the shelf by clicking the mouse and clicking ‘Place’.

32.4.9
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32.4.10 In the ‘Hardware’, tab select ‘Rail’ in the ‘Rail Cover’ field. If the rail does not need to be installed and does not need to be count-
ed, then remove the check mark. Select ‘Hanger Cover’ from the list if you do not need their calculation and installation, then remove the 
check mark from the ‘Include Panel Hangers’. If you want to include ‘Closet Support Fillers’ - then put a tick in the box.

To count all the ‘Hardware’ click ‘Update’ under ‘Add Hardware’ at BOM’.

All selected items will be displayed in the BOM in the ‘Non-Plan Items’ tab.

32.4.10
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33.1.1 To add a comment to the design select the ‘Measurements & Comments’ section on the ribbon panel and click on the ‘Comment’ 
button. 33.1.2 Select the point where the comment is to be placed on the design and left-click. 33.1.3 Type the comment into the text box 
and click the ‘OK’ button. 33.1.4 Use the ‘Tag’ field to assign a tag to the comment. To change the font color on the comment click on the 
‘Color’ button and choose the desired font color. To change the font type, size, and/or format use the drop-down menu and/or correspond-
ing radio button. To show the comment on all the plan views click the ‘All Views’ radio button. To show the comment on selected views 
click the ‘Selected Views’ radio button, then choose the plan view that the comment is to show on.

Note: A tag is used to make a comment about a particular numbered item. Comments are moved, rotated, deleted, and edited using the 
right-click function.

33.1.5 To add a line to the design click the ‘Add Line’ button, select the starting point, drag the cursor to the ending point and left-click. 
To add an arrow to the end of the line, right-click on the line and select the end of the line where the arrow is to be placed and left-click.

33.1.5
33.1.1

33.1.3
31.1.4
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33.2.1 To add a line to the design click the ‘Add Schematic Line’ button, select the starting point, drag the cursor to the ending point 
and left-click. To add an arrow to the end of the line, right-click and select the end of the line where the arrow is to be placed and left-click.

33.2.1
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You can work with the always-open 3D View without closing it, all design changes will be reflected on it automatically. It is more con-
venient to work on two monitors for this feature, but you can use one as well.

34.1.1 Use the ‘Move’ buttons to move the 3D view. You can do the same by clicking and holding the left mouse button.

34.1.2 Use the ‘Zoom’ buttons to zoom in and zoom out the 3D view. You can do the same by clicking and holding the middle mouse 
button (scroll wheel). Note: Do not roll the wheel.

34.1.3 Use the ‘Rotate’ buttons to rotate the 3D view. You can do the same by clicking and holding the right mouse button.

34.1.4 You can hide/show the camera controls panel using the corresponding button in the header menu.

Training Exercise: Show a 3D view. Use the mouse and navigation buttons to rotate and show the design.

34.1.2 34.1.334.1.1

34.1.4
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34.2.1 Use the ‘Save To File’ button to create a PNG file of the current view.

34.2.2 Use the drop-down menu to select the folder where the new PNG is to be saved.

34.2.3 Type in the saved PNG name into the text box.

34.2.4 Click on the ‘Save’ button to save the PNG. The PNG can now be emailed as an attachment.

Training Exercise: Create and save a PNG file of the current 3D view.

34.2.1
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34.3.1 Use the ‘Print’ button to send the current view to the printer. Standard printer functions settings are applied.

34.3.1
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34.4.1 To save the current 3D View camera position click the ‘Saved Views’ button in the top toolbar.

34.4.2 In the left sidebar enter the name of the saved view and click the ‘Save View’ button. When you reopen the 3D window the saved 
3D view will be available in the ‘Saved Views’ field.

34.4.3 Saved 3D View can be removed by clicking the ‘Delete’ button.

34.4.4 If you want to make any of your saved 3D Views a default one (so every time you open the 3D it will be opened in this view) - click 
on the three-dots icon in the top right corner of the sidebar and select the ‘Set as Default’ option.

34.4.134.4.2

34.4.4

34.4.3
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34.5.1 Use the ‘Hide Invisible Walls’ button to hide items as the wall is rotated. Walls, cabinets, and countertops disappear as the walls 
are rotated so that the front of the island can be seen.

34.5.1
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34.6.1 By clicking on the ‘Open/Close Doors’ button in the menu you can open or close doors of the cabinets if you like.

34.6.1
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34.6.2 You can also open or close door of the specific cabinet, by just clicking on it.

34.6.2
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34.7.1 Use the ‘Light’ button to access settings for the light sources.

34.7.2 After clicking the ‘Light’ button left sidebar will appear with a list of all light sources that are used in the design. You can enable or 
disable each light source individually by clicking on the checkboxes next to each of them or adjust their light output by pulling the Intensity 
slider.

34.7.3 Some light sources allow you to change their color, for that you have to click on the color box and select a color you want.

34.7.1
34.7.3

34.7.3
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34.8.1 If you need to adjust the overall brightness of the 3D view, click on the ‘Brightness Control’ button in the menu and use the slider 
on the right for the desired result.

34.8.1

34.8.1
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34.9.1 Isometric 3D View mode is enabled/disabled by clicking on the ‘Isometric View’ button on the menu.

34.9.1
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34.10.1 The ‘Refine’ button allows you to re-render shadows and reflections in the 3D View for a better-looking result.

34.10.2 If you want to increase or decrease the image quality of 3D click on the ‘Render Settings’ button in the menu and adjust the 
render quality slider in the left sidebar for your liking.

Note: You need to restart the 3D window to apply the effect.

34.10.234.10.134.10.2
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34.11.1 Wood texture is now different on various cabinets to avoid the unnaturally tiling effect, however, if you still do not like the wood 
texture on some cabinets you can right-click, and keep selecting the ‘Shuffle Wood’ option on that cabinet until you get the result that you 
like.
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35.1.1 You can send a link to your 3D view using email or directly to the smartphone of your recipient, by using the corresponding but-
tons on the bottom toolbar.

35.1.1
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35.2.1 By selecting the ‘Quality’ checkboxes you can select what quality types should be included when sending to your recipient. The 
‘Expiration’ field allows you to adjust the number of days before the links will expire.

35.1.2
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36.1.1 To create the panorama click the ‘Create Panorama’ button in the menu.

36.1.2 By default camera position is in the middle of the room. You can move the camera or change its angle using provided controls.

36.1.3 After selecting render resolution and clicking the ‘Render’ button, the panorama will start rendering.

36.1.1

36.1.2
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36.1.4 When the rendering process is completed panorama will automatically show up.
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36.2.1 To access the list of existing panoramas, click on the ‘Gallery’ button in the ‘Presentation’ tab of the ribbon panel. In the list, you 
can find the desired panorama by its name or by the date of its creation. Also, there are ‘Quality’ and ‘Resolution’ in the list.

36.2.2 You can view a panorama by selecting it in the list and clicking the ‘Preview’ button at the bottom or by directly clicking on the 
panorama link.

36.2.3 To send a panorama - selected the one in the list and click the ‘Send’ button. The address box will be opened where you can 
specify the recipient.

36.2.1

36.2.336.2.2
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36.2.4 You can copy the link of the panorama by clicking the right mouse button on the panorama link and selecting the ‘Copy Link’ 
option.

36.2.4
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36.2.5 To delete the panorama select it in the list and click the ‘Delete’ button at the bottom.

36.2.5
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37.1.1 In ProKitchen there is the possibility to browse designs in Oculus (Virtual Reality).To do this you need to make a design export 
using the ‘Oculus Rift (.rvo)’ option.

37.1.1
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You must install the ProKitchen Oculus application and connect it before you can run the file.



264PAGE -38.1 MANUFACTURER’S REPORT

38.1.1 To create a cost and parts list for the order, select a catalog from the box and then click the ‘Manufacturer Report’ button.

38.1.2 Some manufacturers allow additional discounts which can be changed in the ‘Shipment Charge’ tab. Once all discounts and 
any additional notes are entered, click on the ‘OK’ button. This will create the manufacturer’s report. Each manufacturer requires different 
information.

Note: A manufacturer’s report needs to be created for each catalog used in the design.

38.1.1 38.1.1

38.1.2
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38.2.1 To create a price and/or parts list for the order click the ‘Customer Report’ button from the ribbon panel.

38.2.2 The ‘Customer Report’ window will appear.

38.2.3 To select the catalog, highlight the catalog description.

38.2.4 Use the ‘Include Catalog in Customer Report’ checkbox to include the information in the report.

38.2.5 To set the tax enter the percentage in the text box.

38.2.6 The design, shipping, and installation charges are set as a percentage or a dollar amount. Use the checkboxes to apply sales tax 
to each item (if applicable).

38.2.7 The ‘Discount’ text box is used to set a discount off the MSRP.

38.2.1

38.2.338.2.2

38.2.4
38.2.5

38.2.6

38.2.7
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38.2.8 To insert a logo into the report click the ‘Browse’ button and select the logo and click the ‘Open’ button.

38.2.9 To include text on the top and/or bottom of the Customer Report use the provided text boxes.

38.2.9

38.2.8
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38.2.10 To select a catalog, use the drop-down menu and click on the catalog. This brings up all the items in the design from the se-
lected catalog.

38.2.11 To change the installation price of a cabinet, double-click the price text box and type in the new price.

38.2.10

38.2.11
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38.2.12 The ‘Project Settings’ tab contains information that will appear in the Customer Report.

38.2.12
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The Customer Report includes all cabinets and accessories in the plan including multiple catalogs.

Note: The navigation button works the same as the Manufacturer Report.
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The Multi-Quote option is used to view up to five door styles side by side on one report. The Multi-Quote option is not available for all 
manufacturers.

38.3.1 To create a Multi-Quote click on the ‘Multi-Quote Report’ button from the ribbon panel.

38.3.2 Use the drop-down menu to select the cabinet line to be used for the Multi-Quote.

38.3.3 Use the ‘Number Of Quotes’ up/down arrows to select the number of different quotes needed. The number of quotes selected will 
show as tabs in the Compare Quotes window.

38.3.4 Use these text boxes and radio buttons as discussed in the Customer Reports section.

Note: The ‘Catalog Settings’, ‘Logo’, and ‘Project Settings’ tabs work in the same manner as discussed in the Customer Reports section.

38.3.1

38.3.3

38.3.4

38.3.2
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38.3.5 Use the ‘Quote #’ tabs to select the individual quote windows.

38.3.6 Use each ‘Quote’ window to set the values for each quote tab.

Note: All ‘Please click to select’ options must be selected.

38.3.5

38.3.6
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38.3.7 The Multi-Quote Report includes all cabinets and accessories in the plan including multiple catalogs in multiple finishes, door 
styles, lines, and wood species.

Note: The navigation buttons work the same as the Customer Report.
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38.4.1 Bill Of Material Report - called BOM, by pressing the ‘BOM Report’ button provides a list of products and prices.

38.4.2 If you click ‘BOM Report No Pricing’ it generates a report with a list of products with dimensions but without prices.

38.4.1

38.4.2
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38.5.1 Generates full report on the entire design, including a list of products, prices, options, pictures with the plan, 2D and 3D. To gener-
ate this report click on the ‘Quick Report’ button on the ribbon panel. You can edit, add comments, and save and print the file in PDF format.

38.5.1
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38.6.1 Ready designs can be mailed. In the file tab click ‘Share’ > ‘Send Using Email’ > ‘Attach Design File’. Choose where to send and 
what to attach to the letter.

38.6.1
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38.7.1 A Combined Report can create reports of several reports or PDF files.

Click the ‘Combined Report’ button and in the opened window, you are prompted to add a file from your computer, remove the file, swap 
files and view the result with the ‘Preview’ button.

38.7.1
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39.1.1 ProKitchen allows you to export the design in different files and use it in other programs, such as AutoCAD, Google SketchUp, 
QuickBooks, and others.
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39.2.1 To save all the settings when you reinstall ProKitchen or transfer it to another computer you can make an export with all settings 
and options selected. Use ‘Export’ > ‘ProKitchen User Data (.zip)’ for it.

39.2.2 In the dialog window, you need to specify which data needs to be exported by checking the desired items and clicking ‘OK’. The 
program will offer you to choose the path for the file. Select the path and click ‘OK’. Data will be saved in this folder.

39.2.1

39.2.2
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39.3.1 To make an export of the design for Oculus Rift go to ‘Export’ > ‘Oculus Rift (.rvo), select the path, and click ‘Save’. To view the file 
you need to install the ProKitchen Oculus application and connect the Oculus device to your PC.

39.3.1
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39.4.1 To export to Quick Books click ‘Export’ > ‘QuickBooks’ > ‘All Customers (.iff)’ or ‘Current Design (.iff)’. ‘QuickBooks All Customers’ 
exports data on all customers and ‘QuickBooks Current Design’ exports data about the design.

39.4.1
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39.5.1 To export the design in AutoCAD, press ‘Export’ > ‘AutoCad’. In a dialog ‘AutoCAD Export’ select what data needs to be exported 
(select with a tick next to an option).

Note: Using the ‘Select/Unselect All’ button, you can select or remove all at once.

Click ‘Browse’ to select the path to save the file. Then click ‘Export’ and you will get the message that the export is ready.

39.5.1
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39.6.1 To export the design to Google SketchUp click ‘Export’ > ‘Google SketchUp’. In the dialog window select the path where to save 
the file and click the ‘Save’ button. The design will be saved in 3ds format, and you have an opportunity to open it in SketchUp.

39.6.1
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39.7.1 To export data to Cabinet Vision, click ‘Export’ > ‘Cabinet Vision’.

39.7.1
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40.1 These allow importing of vital information in the program such as the customer database, solutions, dealer information, design 
files, print settings, and default settings. This function is used if transferring the program from one computer to another. ProKitchen gives 
the opportunity to use files of various formats for viewing.
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40.2.1 To import ProKitchen settings that were previously exported click ‘Import’ > ‘ProKitchen’ > ‘ProKitchen User Data (.zip)’. In the 
opened window find the path to the desired file, and click ‘OK’.

40.2.2 Opens a window in ProKitchen with a list of data that is stored in the file, removing or adding a check mark, you need to select 
which data you want to import. Click ‘OK’.

40.2.3 Opens a window with the message of duplicate items and the option to replace data yes or no.

40.2.1

40.2.2 40.2.3
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40.3.1 To import Solutions go to ‘File’ > ‘Import’ > ‘ProKitchen Solutions (.grp)’. Using a dialog window find a solution file you need and 
then click ‘Open’.

40.3.1
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40.4.1 To import customers from Quick Books click ‘Import’ > ‘QuickBooks’ and select ‘QuickBooks Desktop All Customers’ or ‘Quick-
Books Online All Customers’ depending on your QuickBooks application type.

40.4.1



288PAGE -40.5 AUTOCAD

40.5.1 To import files from AutoCAD, press the ‘File’ > ‘Import’ > ‘AutoCad’. In the dialog select the AutoCAD file you want to upload to 
ProKitchen and then click ‘Open’.

40.5.1



289PAGE -40.6 20-20

40.6.1 To import files from 20-20, press the ‘File’ > ‘Import’ > ‘20-20’. In the dialog select the 20-20 file you want to upload to ProKitchen 
and then click ‘Open’.

40.6.1
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40.7.1 To import files from ETemplate, press the ‘File’ > ‘Import’ > ‘ETemplate’. In the dialog select the ETemplate file you want to upload 
to ProKitchen and then click ‘Open’.

40.7.1



291PAGE -40.8 INNODRAW

40.8.1 ‘File’ > ‘Import’ > ‘InnoDraw’ allows you to import InnoDraw design and work with it in ProKitchen.

40.8.1
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ProKitchen allows you to use various models of the 3D model Browser in design.

41.1.1 Click on the ‘SketchUp’ button on the ribbon panel. In the search field of the ‘3D Warehouse’ tab, you can enter what you’re looking 
for and the program will display all the available models.

41.1.1
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41.1.2 After selecting the appropriate model click on the red arrow and load it. Model opens in ProKitchen. Adjust the desired size and 
description and add to the plan by clicking the button ‘Add To Design’.

41.1.2

41.1.2
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41.1.3 The ‘3D Models’ tab contains all previously saved and downloaded models. Double-click on any model to access the dialog win-
dow where you can edit the description and size or add it to the design.

41.1.3
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42.1.1 Click the ‘EZ-Link’ button on the ribbon panel. Program export design data and save the selected format on a server. This file can 
then be imported into other programs.

Note: Not available for all catalogs.

42.1.1



296PAGE -42.2 SPRUCE

42.2.1 You can export data to Spruce by pressing the ‘Spruce’ button on the ribbon panel, then selecting catalog (if you have multiple in 
your design) and selecting a file output path.

42.2.1
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42.3.1 You can export data to Saberis by pressing the ‘Saberis’ button on the ribbon panel, then selecting catalog (if you have multiple 
in your design) and selecting a file output path.

42.3.1
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42.4.1 You can export data to Bistrack by pressing the ‘Bistrack’ button on the ribbon panel, then selecting catalog (if you have multiple 
in your design) and selecting a file output path.

42.4.1
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43.1.1 Use the ‘Print’ > ‘Print Preview’ from the ‘File’ menu.

43.1.2 To set the orientation of the prints select the ‘Setup’ button.

43.1.3 Use the Size drop-down menu to select the paper size. Use the Source drop-down menu to select the printer source. Select the 
orientation of the page using radio buttons. Use the text boxes to set the margin dimensions.

Hint: The smaller the outline margins the larger the print area will be.

43.1.2

43.1.3

43.1.1
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43.1.4 Use the ‘Stamp’ button on the Print Preview page to change the text on the printed views. Click on the ‘Text’ tabs to select the 
text to be changed. The width and height of the text boxes can be changed by using the ‘Width’ and ‘Height’ text boxes. The font in each 
text box can be changed using the ‘Font’ drop-down menu and ‘Style’ checkboxes.

43.1.4
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43.1.5 ‘Print Scale’ > ‘Fit To Page’ allows the drawing to fit the selected paper size. ‘Ratio’ allows the drawings to be drawn to scale.

43.1.6 ‘Print Area’ > ‘Entire Design’ prints the complete design on the page. ‘Display’ prints what is currently displayed on the screen.

43.1.7 ‘Page Range’ > ‘All Views’ to print all the floor-plan view(s). Select ‘Plan Views’ to print the current floor-plan view(s). Select ‘Se-
lected Views’ and click the ‘Browse’ button to select the specific view(s) to be printed.

Note: Elevations must be created before they can be printed.

Once all selections are made click the ‘OK’ button to go back to the ‘Print Preview’ window then click the ‘OK’ button to preview the pages 
to be printed.

43.1.5

43.1.7

43.1.6
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43.2.1 It is possible to select a template to print designs. Use ‘Print’ > ‘Print Template’ from the file tab. Opens a window with the pos-
sible templates, select what is suitable for you by clicking on it with the mouse.

43.2.2 Use the ‘Page Format’ to select the paper size. Use the ‘Source’ to select the printer source. Select the orientation of the page 
using the radio buttons. Use the text boxes to set the margin dimensions.

43.2.3 Use the ‘Stamp’ button on the Print Preview page to change the text on the printed views. Click on the ‘Text’ tabs to select the 
text to be changed. The width and height of the text boxes can be changed by using the ‘Width’ and ‘Height’ text boxes. The font in each 
text box can be changed using the ‘Font’ field and ‘Style’ checkboxes.

43.2.1

43.2.3

43.2.2
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44.1 You can access Dynamic Design Showcase (DDS) by clicking the ‘Dynamic Design Showcase’ button on the ribbon panel. It allows 
you to create custom print representations of your designs.

44.1
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44.2 The top toolbar has numerous controls that you can utilize for creating your document.

44.3 Below are shown the pages of your document.

Note: you can rearrange the order of the pages at any time, by dragging and dropping a page you want to move into the desired position.

44.4 Each page has a footer that you can adjust by using the ‘Print Templates’ and ‘Stamp Forms’ features described in the Print Preview 
segment above.

44.2

44.3

44.4
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44.5 Right-clicking on the frame brings up a menu.

44.6 The ‘Add’ option allows you to select what type of content will be displayed inside the frame.

44.7 By using the ‘Send’ options you can create a multiple-layered design. ‘Send to Front’ will bring up the frame to the top level, so it 
will be displayed on top of all the frames below it, and ‘Send to Back’ will put the frame at the far back position, so all the frames above it 
will be shown on top of it. ‘Send Forward’ and ‘Send Backward’ will move the frame one step in mentioned direction accordingly.

44.8 The ‘Lock’ option is used when you don’t want accidentally adjust a specific frame during your work with the document. You can 
unlock it at any time.

44.9 Depending on the type of frame, clicking on the ‘Attributes’ option will bring a dialog in which you can adjust options specific to this 
type of frame. Like style, color, and thickness of the frame border or font size, color, style of the text, etc.

44.5

44.9

44.6

44.7

44.8
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The final design of your document can have multiple pages containing different information about your design.
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45.1.1 Use the ‘Find Customer’ button to access the Advanced Customer Search window.

45.1.2 Type specific information in the text box.

45.1.3 Select the search method.

45.1.4 If the name is found with the entered information it will appear in the Search Results window. Click on the customer’s name to 
access the plan(s) for the customer.

45.1.5 The ‘Edit’ and ‘Delete’ buttons are used to edit or delete customer information.

45.1.2

45.1.1

45.1.3

45.1.4

45.1.5
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45.2.1 Use the ‘Find Design’ button to access the Advanced Design Search window.

45.2.2 Type specific information in the text box.

45.2.3 Select the radio button in which the search is to be searched. Search by ‘Order Number’, ‘Job Name’, ‘Contract #’, ‘P.O. #’, ‘Status’, 
‘Customer’, and ‘Date Range’. If searching by date range click the first ‘Calendar’ button and set the first date then click the second ‘Calen-
dar’ button to set the second date. The program will bring up all designs between these dates.

45.2.4 If the name is found with the entered information it will appear in the ‘Search Result’ window. Click on the customer’s name to 
access the plan(s) for the customer.

45.2.5 ‘Open’, ‘Edit’, and ‘Delete’ buttons are used to open the selected design and edit or delete the customer information.

45.2.2

45.2.1

45.2.4

45.2.3

45.2.5
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Saving Images

To save an image as a JPEG file click the ‘Save As Image’ from the file tab menu and save the image into a file.

Backing Up Designs

A backup file can be made at any time by clicking on ‘Auto Backup’ in the file tab menu. This will create a time and date stamped folder 
of the existing project.
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46.2.1 ‘Account’ > ‘License’ from the file tab contains the ProKitchen License Agreement and License Keys.

Use the License Keys menu to access the Product Key (the key that comes with the program disk) and Hardware ID (the unique code of 
your computer). The Activation Key is the number that you receive from Customer Service. If the Activation key is needed call Customer 
Service at the number in the Activation Window.
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47.1.1 To see information about the current ProKitchen version click ‘Help’ in the file tab. Above is the version of ProKitchen, Installation 
Key, License Expiration data, and a list of all the catalogs specified in your ProKitchen and their versions.
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47.2.1 To access the ProKitchen Help guide, click on the ‘Index’ button in the ‘Help’ section of the file tab menu. It is designed as a quick 
reference guide. To use it click on the list folder containing the general category, and then the sub-category. 
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47.3.1 Use the ‘Video Tutorials’ button to open up our collection of training videos that you can browse and find the topic you are inter-
ested in learning.
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47.4.1 If an error or a problem occurred you can report it by clicking on the ‘Support’ button in the file tab menu and describing it by using 
provided fields on the ‘Create Ticket’ page of our website. So our support team can handle it.
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47.5.1 The ‘Portal’ button will open the ProKitchen Portal page in your browser. There you can access information about our projects, 
see your billing details, etc.
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47.6.1 ’Chat with Us’ brings up a chat window where you can ask questions to our support team.
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48.1 ‘NKBA Guidelines’ - opens the PDF file which describes the standards of NKBA.

48.2 ‘Verify Design’ - you can check if the design corresponds to NKBA standards.

48.148.2
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49.1.1 To open designs from Cloud click ‘Open’ > ‘Cloud’ in the file tab and then select a design from the dialog.
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49.2.1 To save the design to Cloud click ‘Save As’ > ‘Cloud’ in the file tab and then type in a design filename and click the ‘Save’ button.
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49.3.1 You can adjust the ‘Auto-save’ and ‘Auto-backup’ options inside the ‘Application’ tab of the ‘Default Settings’.

49.3.2 All the backups will be available in the ‘Open Design from Cloud’ dialog.

49.3.1
49.3.2
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49.4.1 You can share your Cloud designs, by simply marking them with the ‘Share’ button.

49.4.1
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